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1	 About this operating manual
The LaserDiagnosticsSoftware LDS is the control center for operating all PRIMES devices of the “+” generation 
and various power measurement systems (PowerMonitor, CompactPowerMonitor, ECPowerMonitor, Cube). 
Older devices (FM, LQM, MSM, BM-HQ) work with the previous version LDS 2.98.

This operating manual is for the basic version of LDS and describes software installation, file administration, 
and the display and analysis of measurement data.

A detailed description of installation and configuration of measuring devices and the performance of 
measurements is provided in the operating manuals for individual devices.

This operating manual describes the software version valid at the time of printing. This operating 
software undergoes continuous development.
It is therefore possible that a more recent version is available.

2	 Technical support
For questions about LDS or the analysis of measurement results, please contact technical support: 
•	 Email: support@primes.de
•	 Phone: +49 6157 9878 2500

3	 Icons and conventions
The operating manual makes use of the following icons and conventions:

Here you will find useful information and helpful tips.

 Indicates a single action.
If multiple actions appear one below the other, then the order of their execution is immaterial,
or they are alternative procedures.

1.
2.
...

A numbered list identifies a sequence of actions that must be executed in the specified order.

 Indicates the result of an action to explain processes that take place in the background.

	 Indicates an alert that calls attention to visual feedback from the device or software.
Such alerts help users check whether an action has been successfully executed. In many cases, 
they also lead to next action.

Indicates a control function that is to be pressed or clicked.

Indicates an element described in the text (e.g., an input field).
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4	 First steps

4.1	 Install and run program

The basic version of LDS is included with the device. PRIMES will also be happy to provide you 
with a link to download the current version. To do so, contact your sales partner or contact us by 
email: support@primes.de

1.	 Please ensure:
•	 System requirements are met.
•	 You have administrator rights.

2.	 Close all programs on the PC.

3.	 Insert the PRIMES thumb drive into 
the PC and open the directory.  
In the standard configuration, 
Windows automatically opens the 
removable storage device.

System requirements:

•	 Intel Pentium Core i3 or better
•	 Windows 10 (64-bit version)
•	 At least 4 GB RAM; 8 GB RAM recommended
•	 Display resolution: Full HD (1920x1080) at 100% scaling
•	 A USB or Ethernet interface for connecting the measuring device

4.	 Double-click on the file Setup LDS 
v.X.X.msi to start installation.

5.	 Follow the instructions on the screen.

	x If no other Iocation is specified, 
then the main program 
LaserDiagnosticsSoftware.exe  
will be copied to the directory  
C:\Programme\Primes\Software. 

6.	 LDS can be launched in multiple ways:
	X Double-click on the program icon in 

the start menu.
	X Double-click on the desktop shortcut.

 The start logo appears briefly.

 The start screen appears.
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4.2	 Select mode of operation on the start screen

When the program is first started, the start screen appears. An operating mode can be selected here.
Only then does the actual user interface open.

Set options

Before selecting the operating mode, various options can be set. These can be found in the bottom-right 
corner of the start screen.

	X Set the options as required.

These options can also be set 
from within the user interface in 
the menu Extras > Options .

•	 Automatic search for update 
activates automatic notification of 
software updates.

•	 Show tutorial activates the tutorial 
function. The tutorial provides brief 
instructions, on a blue background, 
about the basic operating steps.

•	 Show start screen makes the start 
screen appears at every new start.
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Select operating mode

When the program is first started, one of the following operating modes must be selected, along with the 
corresponding user interface: Measure / Analyze .
At each program restart, there is also the option to select the previous user interface by clicking Last layout 
(the following option must be activated: Show start screen).

Operating mode Measure

1.	 Select the Measure operating 
mode to connect the software to a 
measuring device in order to conduct 
a measurement.

	The user interface is loaded. 
The Devices tab appears in the 
foreground and the Connections 
window is open.

All PRIMES devices found in the network 
are listed in the window Connections.

2.	 Select one of the listed devices by 
clicking in the list. 

3.	 Connect a measuring device via the 
Connect to device button. Observe 
also the information in the device 
operating manual.

Window Connections

Tab Devices

	The connected device appears in the 
Devices tab. 

4.	 Click on the desired device.

	The settings window Device control 
appears. 

5.	 Select the appropriate measuring 
mode.

6.	 Enter the device and measurement 
parameters and start the 
measurement as described in the 
device operating manual.

Settings window 
Device control
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Operating mode Analyze

1.	 Select the Analyze operating mode to 
display and analyze measurements. 

	The user interface is loaded. 
TheProjects tab appears in the 
foreground. The toolbench is empty.

2.	 Load a project into the Projects tab, 
as described in Chapter 5.4.5 on 
page 19.

3.	 Open a measurement with a tool, 
as described in Chapter 6.1.2 on 
page 42.

Tab Projects

Operating mode Last layout

	X To load the user interface from the 
previously used layout, select the 
operating mode Last layout.
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5	 The user interface

5.1	 Layout and operation of user interface

The user interface is divided into functional areas, moving from left to right according to the sequence of 
operating steps:

•	 Left: Connect device and conduct measurements (operating mode Measure) or load measurements 
(operating mode Analyze).

•	 Center: Select a measuring mode in the Device control. area to choose options and set parameters 
This settings window only appears if a measuring device with a corresponding measurement function 
has been selected in the Devices tab.

•	 Right: Display and analyze measurements in main window (operating modes Measure and Analyze).

                                

Menu bar

Buttons  
Start / Stop

Element Status

Settings window 
Device control 

Main window with toolbenches 
and tool windows

Quick selection bar 

Perform/load

Operation of user interface: left to right

Select measuring 
mode, enter options Show and evaluate measurements

Progress bar

Settings window 
with tabs Devices / 

Projects /  
(if appropriate, 

Control)

Fig. 5.1:	 Layout and operation of user interface
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Elements Explanation

Menu bar The menu bar offers a wide range of operating and setting options.
Further information can be found in Chapter 5.5 “The menu bar” on page 26.

Settings window 
with tabs Devices / 
Projects / (in some 

cases, Control)

Clicking on the Devices / Projects tab brings this to the foreground. In this way, it is 
possible to switch between the  Measure / Analyze operating modes.

•	 In the Devices tab, measuring devices can be connected to LDS. All connected 
devices are listed along with their measurement functions. 
Further information can be found in Chapter “The “Devices” tab” on page 14. 
Once a connected device with a corresponding measurement function has been 
selected, the Device control settings window appears (see below for description).

•	 Measurement projects are loaded into the Projects tab. The measurements in 
this tab can be opened with the tools in the main window. Projects in this tab are 
displayed in a hierarchically structured project tree. 
Further information can be found in Chapters “The “Projects” tab” on page 15 
and “Show and evaluate measurements” on page 37.

Buttons  
Start / Stop

The buttons in this window are used to start/stop a measurement. In the case of 
scanning devices, the rotation of the measuring tip can also be halted here.
Further information can be found in the device operating manuals.

Element Status
Status displays the progress of a current measurement. 
Further information can be found in the device operating manuals.

Progress bar Progress bars display the progress of measurement, saving, loading and calculating 
project tree elements.

Settings window 
Device control 

When a device is connected in the Devices tab and a corresponding measurement 
function has been selected, the Device control settings window appears.

In the case of many devices, a measuring mode can also be selected here.
The measuring mode contains all the setting options relevant for a measuring task, 
clearly arranged in a menu.
Further information can be found in the device operating manuals.

By clicking on the adjacent  icon, the settings window can be collapsed to form a 
dedicated tab. It then appears alongside the Devices / Projects tabs. Clicking on the 
gear icon  will return to the previous view.

Main window  
with toolbenches  
and tool windows

Measurement data can be displayed and analyzed in the main window of the user 
interface. A variety of tools are available for this purpose, all of which can be displayed 
in separate windows.
For additional clarity and flexibility, these tool windows can be displayed in any 
number of tabs as toolbenches.

Quick selection bar The user interface can be customized here:
•	 Language: German/English
•	 Color scheme: light/dark
•	 Font size: M/L/ XL
•	 GUI: Show/hide menu bar and script console (see Script editor tool in Tab. 6.1 

on page 37).

Tab. 5.1:	 Elements of the user interface
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5.2	 Overview of control functions for all elements and windows

The elements and windows of the user interface contain different control functions in the form of icons. 

Icon Function

 / In many elements and windows:
	X To open/close a drop-down menu / drop-down list of the sub-elements of a project tree 

element, click on the arrow right/arrow down.

 / In the top-right corner of a toolbench:
	X For a cascaded/tiled arrangement of tool windows, click on the frame icon (left/right).

In the main window:
	X To add another toolbench, click on the plus symbol.

In the Devices tab:
	X To connect a device, click on the plus symbol. Further information can be found in the device 

operating manuals.

 / In some graphic displays:
	X To zoom in / zoom out in a graphic, click on the plus/minus symbol.

In some elements and tool windows:
	X To open a settings window, click on the gear icon.

In the tool windows, the gear icon only appears when the mouse cursor is hovered over the 
window / the relevant element of the window.

In the Device control settings window and the main window:
	X To close the Device control settings window or the Devices / Projects tab, click on the 

double arrow.

In the top-left corner of a tool window:
	X To mark in a project tree the measurement data displayed in a tool, click on the flag icon.

With this function, the measurement data displayed in a tool can be clearly identified in the 
project tree. This improves readability when a lot of tool windows are open in one toolbench 
simultaneously.

? In the top-right corner of a tool window:
	X To display help text for a tool, click on the question mark.

	The LDS operating manual then appears in a new window. The manual is open at the 
chapter for the tool in question.

In some tool windows:
	X To open an information window, hover the mouse cursor over the information icon.

The information window provides relevant explanations or other help.

 / In the top-right corner of a tool window:
	X To lock/unlock the contents of a tool window, click on the lock icon (left/right).

This function makes it easy to compare data sets in multiple tools. Further information can be 
found in Chapter 6.1.2 “Opening project tree measurements in tools” on page 42.

Lots of windows of the user interface can be adjusted for size by clicking and dragging the frames.
In the top-right corner of many windows, there are also the standard icons to shrink, minimize and 
maximize the window. It may be necessary to activate the window before these control icons appear.

If the window is maximized, there are the following options:
	X To minimize the window, click on the underline icon.
	X To shrink the window, click on the double-frame icon.
	X To close the window, click on the cross symbol.

If the window is neither maximized nor minimized, there are the following options:
	X To minimize the window, click on the underline icon.
	X To maximize the window, click on the frame icon.
	X To close the window, click on the cross icon.

If the window is minimized, there are the following options:
	X To enlarge the window, click on the double-frame icon.
	X To maximize the window, click on the frame icon.
	X To close the window, click on the cross icon.

Tab. 5.2:	 Control icons for elements and windows
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5.3	 The “Devices” tab

Clicking on the Devices tab brings this to the foreground and activates the operating mode Measure.
In this tab, the following control options are available:

	X To connect a device with LDS, click 
on the plus symbol. 

	The Connections window appears.

Further information can be found in the 
device operating manuals.

	X To open the Device control settings 
window, click on the required device.

	X To turn the Device control settings 
window into a dedicated tab, click on 
the double arrow.

Once settings have been made,
this frees more space for displaying 
measurement data in the main 
window.

	The tab then appears alongside the 
Devices / Projects tabs.

	X To incorporate the Device control 
settings window in the Devices tab, 
click on the gear icon.

	X To show warning information about the 
connected device,hover the mouse 
cursor over the warning triangle (if 
available).

The warning triangle appears when, for 
example, the service interval of the device 
has expired.

	X To display a device-related context 
menu, right-click on the device.

The options in the context menu are 
explained in Tab. 5.3 on page 15.
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Option Explanation

Device settings Opens the Device settings window.

For communication within a network, an address is stored in the Static 
IP address field in the LDS and the Use DHCP function is activated.

When connecting to the network, the device first waits to be provided 
with an IP address via DHCP. If this fails, it reverts to the static IP address.
If Use DHCP is deactivated, the device reverts to the static IP address. 
This ensures faster network connection.

1.	 Enter a valid IP address or use the Use DHCP option.
2.	 Click OK to confirm.
3.	 Switch the device off and on again.

EEPROM Here, adjustments can be made to PRIMES – e.g., for service requirements.

Create diagnostics file Opens a Windows Explorer window for the purpose of saving a file with 
the LDS file extension .diagnose. 
This file contains device status data for the purpose of troubleshooting. 
These can only be analyzed by PRIMES.
This file does not contains any data from your PC or laptop.

Reconnect Reconnects the device with LDS (e.g., after connection has been lost).

Disconnect Disconnects the device from LDS.
Further information can be found in the device operating manuals.

Tab. 5.3:	 Context menu options in the Devices tab

5.4	 The “Projects” tab

Clicking on the Projects tab brings this to the foreground and activates the operating modeAnalyze. 

5.4.1	 Project tree elements and their hierarchy

LDS categorizes measurement data in logical units. To enable clear and easy handling, these units are shown 
as elements in the project tree of the Projects tab.

Level 4

Level 1

Level 2

Level 3

Plane
Plane
Plane
Plane

Project

Series
Series
Series

Caustic
Caustic
Caustic
Caustic
Caustic

Fig. 5.2:	 Example of a project tree in the Projectstab.

The project tree contains different types of element. These are assigned to a maximum of four hierarchy 
levels. Some of these elements have themselves sub-elements. Others are fundamental elements, which 
contain the basic measurement results. 
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Project Project is an element of hierarchy level 1. It may occur repeatedly in the project 
tree and can be saved individually as a file with the LDS file extension.lpf.
This element can also contain one or more elements of the type Series.

Series Series is an element of hierarchy level 2. It may contain one or more sub-
elements of the same kind; e.g., the element Caustic.

Caustic Caustic is an element of hierarchy level 3. It contains the results of a caustic 
measurement and one or more elements of the type Plane.

Plane Plane is a fundamental element of hierarchy level 4. It contains the results  
of a plane measurement.

Series Series is an element of hierarchy level 2. It may contain one or more sub-
elements of the same kind; e.g., the element Linescan.

Linescan Linescan is a fundamental element of hierarchy level 3. It contains the  
results of a linescan measurement.

Series Series is an element of hierarchy level 2. It may contain one or more sub-
elements of the same kind; e.g., the element SFM vector series.

SFM vector series SFM vector series is an element of hierarchy level 3. It contains one or  
more elements of the type Vector.

Vector Vector is a fundamental element of hierarchy level 4. It contains the results  
of a single vector measurement from the ScanFieldMonitor SFM device.

Series Series is an element of hierarchy level 2. It may contain one or more sub-
elements of the same kind; e.g., the element SFM delay time.

SFM delay time SFM delay time is an element of hierarchy level 3. It contains one or more 
elements of the type Vector.

Vector Vector is a fundamental element of hierarchy level 4. It contains the results  
of a single vector measurement from the ScanFieldMonitor SFM device.

Series Series is an element of hierarchy level 2. It may contain one or more sub-
elements of the same kind; e.g., the element Cube series.

Cube series Cube series is an element of hierarchy level 3. It contains one or more 
elements of the type Cube measurement.

Cube measurement Cube measurement is a fundamental element of hierarchy level 
4. It contains the results of a single vector measurement from the 
ScanFieldMonitor SFM device.

Series Series is an element of hierarchy level 2. It may contain one or more sub-
elements of the same kind; e.g., the element Power measurement.

Power measurement Power measurement is a fundamental element of hierarchy level 3.  
It contains the results of a power measurement.

Fig. 5.3:	 Types of project tree elements and their hierarchical arrangement
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5.4.2	 About the project tree elements

When creating a project tree element, it is automatically assigned a name. If required, the element can also 
be assigned an alternative name via the context menu (see Chapter 5.4.6 “Context menus” on page 21). 
This alternative name should be different to the name automatically assigned by the system to the element 
type (see Chapter 5.4.1 “Project tree elements and their hierarchy” on page 15). PRIMES recommends 
giving the project tree elements a descriptive name.

In the project tree, further information about an element is displayed next to its name as follows:

•	 As graphical elements next to the name of the project tree element (icons, dashes, colors).
•	 As text in a window that appears when the mouse cursor hovers over the project tree element. This 

contains information such as the type of element, its name, saved measurement data, errors and 
instructions for solving these errors.

Element-related  
information window 

Project tree with graphic 
information elements

Project tree element with  
mouse cursor hovered above it

Fig. 5.4:	 About the elements in a project tree
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Graphical 
representation

Information

 / Arrow right/down:
The element contains sub-elements. Clicking on the arrow shows/hides these sub-elements.

 /  / Shows element type.
Further information on element types can be found in Chapter 5.4.1 “Project tree elements 
and their hierarchy” on page 15.

The icons can be gray or red.
Further information can be found in Chapter 5.4.3 “Review of measurements in project tree” 
on page 18.

 /  / 
 /  / 

Speech bubble:
This element contains a comment.

Users can assign comments to any elements.
See the menu item Add comment in Tab. 5.6 on page 22.

* Asterisk next to the name:
The element or at least one of it sub-elements contains unsaved changes.

Green lines above and below the element Caustic:
This element has been selected as a reference.

Further information can be found in Chapter “Reference tab” on page 104

Gray background:
The element has been clicked or the mouse cursor is hovering over the element.

Tab. 5.4:	 Graphical display providing element-related information in project tree

5.4.3	 Review of measurements in project tree

Element icons in a project tree may be gray or red (see Fig. 5.4 on page 17). Red indicates a warning in 
the following cases:
•	 The measurement was made outside device specifications.
•	 At least one of the measured parameters is invalid.
•	 At least one of the measured parameters lies outside of outside the permissible limits of the reference 

measurement set by the user (only for the element Caustic; see chapter “Reference tab” on page 104).

The information window for a red-colored element contains a description of the error and, if applicable, 
instructions for correcting the error (see Fig. 5.4 on page 17).

If an element in a project tree is marked red, then so are all the other higher-level elements above it. 
Conversely, an element may be marked red without any of the elements below it also being marked red. 
For example, the element Caustic can be marked red although the elements below it all meet the required 
criteria. The reason for this is that only the limit values of caustic parameters were violated (e.g., because the 
minimum measurement area along the z-axis was not reached; see Fig. 5.4 on page 17).

In the project tree, the element Caustic is always reviewed on the basis of the default standard algorithm 
Invariant moments. Conversely, in the Review tab of the Caustic analysis tool, this review is always based 
on the algorithm that is currently selected for that tool.
For this reason, the review in the Review tab may be different to the analysis in the project tree. 
The default standard algorithm can be selected in the menu barExtras > Options > Software > Standard 
algorithm.

Further reviews of the parameters of an element can be performed in the many tools in which the respective 
element can be opened.
Details are available in Chapter 8.2 “Review of parameters with colored markers” on page 140.
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5.4.4	 The toolbar above the project tree

Various command icons are arranged above the project tree. If a command is not available in a specific 
context, the respective icon is shaded gray.
Some of these commands can also be selected via the File menu.

Icon File > menu Function

Open Opens a Windows Explorer window for the purpose of opening a file 
with the LDS file extensions:

•	 .lpf (LDS 1.3.1)
•	 .foc (LDS 2.98)

This file contains an LDS project. The file is loaded into the Projects tab.

Save as Opens a Windows Explorer window for the purpose of saving a file with 
the LDS file extension .lpf.
This file contains the LDS project that has been selected in the 
Projects tab.

PDF export Opens a Windows Explorer window for the purpose of saving a file with 
the file extensions:

•	 .pdf
•	 .png 

This file contains a report for the measurement that has been selected in 
the Projects tab.

Before saving a measurement report, select the required document 
template (report template) from a drop-down list. Different templates are 
available depending on the type of measurement.

CSV export Opens a Windows Explorer window for the purpose of saving a file with 
the file extension .csv. 
This file contains the numerical data of the measurement that has been 
selected in the Projects tab.

Opens the context menu for a project tree.
Further information can be found in Chapter 5.4.6 “Context menus” on 
page 21.

Tab. 5.5:	 Command icons above the project tree

5.4.5	 Administration of projects

LDS projects are saved in a project file with the LDS extension .lpf. Please note that the name shown in the 
project tree is not necessarily the name of the project file. The project name and file name may be different.

PRIMES recommends giving projects in the project tree a descriptive name. When saving the project file, the 
designated project name is also saved.

Open projects

A project file can be opened in a variety of ways:

	X Select File > Openin the menu bar or click on the  icon above the project tree. This opens a 
Windows Explorer window. Now select a project file with the LDS extension lpf.

	X In a Windows directory, click on a project file with the LDS extension lpf. Press down the left mouse 
button and drag the file to anywhere on the LDS user interface.

	 The file is loaded into the Projects tab and the project data are calculated. Two progress bars in the 
bottom-left corner of the user interface display the state of progress. If required, calculation can be 
halted by clicking on the cross symbol ×.
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Files from the predecessor version (LDS 2.98) can be opened.  
These files have the LDS extension .foc. The following options are available:
•	 If no project is selected in the project tree, then a project with the name of the opened file will 

created in the project tree. The measurement is then saved as a sub-element of this project.
•	 If a project is selected in the project tree, then the measurement is stored as a sub-element of 

this project.

Create projects

1.	 Click on the free space beneath the project tree. Open the context menu by right-clicking or by clicking 
on the  icon above the project tree. 

2.	 Select the menu item New project (see Chapter 5.4.6 on page 21).

	 A new project appears in the project tree with the name Project.

3.	 If required, use the context menu to alter the project name in the project tree (see Chapter 5.4.6 on 
page 21). Give the project a descriptive name that meets your purposes.

If necessary, the project will be saved as described in Chapter Chapter  “Saving projects as a new file” on 
page 20.

If no project is created or selected when a measurement is started, a new project is automatically 
created. The measurement is then saved as a sub-element in this new project.If a project is 
selected from a project tree, the measurement is then saved as a sub-element of this project.

Saving projects as a new file

1.	 Select the project in the project tree.
2.	 Select File > Save as in the menu bar.

	 A Windows Explorer window opens. The project name of the selected project is displayed in thefile 
name field. 

3.	 Select a storage location. 
4.	 If necessary, alter the file name and then save the file.

	 A progress bar in the bottom-left corner of the user interface displays the state of progress.

Save changes to projects

The asterisk * icon next to the name of a project tree indicates that an element or at least one of its 
sub-elements contains unsaved changes.

1.	 In the project tree, select the project that contains unsaved changes. Also select any sub-element of the 
project − in any case, the project is always saved.

2.	 Select File > Save in the menu bar.

	 A progress bar in the bottom-left corner of the user interface displays the state of progress. Once 
saving has been completed, the asterisk icons * next to the project tree elements of a project disappear.

Delete projects 

	X Select a project in a project tree and press the Delete key or select Delete in the context menu 
(see Chapter 5.4.6 on page 21).

	x The project is deleted from the project tree. The project file (if any) is not deleted from the file system.
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Merge projects

Multiple projects can be merged into one via the context menu.

1.	 Load the relevant projects into the project window.
2.	 Click on the free space beneath the project tree. Open the context menu by right-clicking or by clicking 

on the  icon above the project tree. 
3.	 Select the menu item Merge projects (see Chapter 5.4.6 on page 21).

	x The projects are merged into one project with the name “Merged project.” A comment is created that 
lists the names of the merged projects.

5.4.6	 Context menus

Via the Projects tab, numerous functions can be selected via context menus: 

Opening an element-related context menu
1.	 Click on the project tree element.
2.	 Then open the context menu by right-clicking or by clicking on the  icon above the project tree.
3.	 Click on the relevant menu item.

Opening a tab-related context menu
1.	 Click on the free space beneath the project tree.
2.	 Then open the context menu by right-clicking or by clicking on the  icon above the project tree.
3.	 Click on the relevant menu item.

Element-related  
context menu

Project tree

Selected project tree element

Fig. 5.5:	 Example of an element-related context menu
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Menu item Function

Show Displays within a suitable tool the measurement data stored in the selected 
element.

Cut Deletes the selected element and moves it to the clipboard.

Paste Inserts an element from the clipboard as a sub-element of the selected 
element. 

Export graphic (.png) Opens a Windows Explorer window for the purpose of saving a file with the 
file extension .png. 
This file contains the false-color views of the plane(s) of a caustic.

Show in Windows Explorer Opens a Windows Explorer window containing the storage location of a 
saved project file.

Is reference measurement Activates/deactivates the selected caustic as reference measurement. 
Further information can be found in Chapter “Reference tab” on page 104.

Add comment Users can assign comments to any project tree elements.

In order to enter a comment, proceed as follows:
1.	 Select menu item in the context menu of the element in question.

	The comments window opens.

2.	 Enter text.
3.	 To confirm a comment, click on the button.

	A speech bubble indicates the presence of a comment in the project 
tree.

In order to read/edit/delete a comment, proceed as follows:
1.	 Click on the relevant speech bubble icon in the project tree.

	The comments window opens.

2.	 Read or edit the text. To delete a comment, simply delete the text.
3.	 To confirm the change, click on the Save button.

	When all text has been deleted from a comment, the speech bubble 
icon disappears from the project tree.

Any comment added to the elements Plane / Caustic is also displayed in 
the Details tab in the Plane analysis / Caustic analysis tools.
(See Chapter 6.3.2 “Plane analysis” on page 74 /
Chapter 6.3.6 “Caustic analysis” on page <?>).

Delete Deletes a selected element from a project tree.

1.	 Call up menu item in the context menu of the element in question.

	The element is deleted and the asterisk icon * appears next to the name 
of the element above it.

2.	 If required, save the higher-level project by clicking on it and selecting 
File > Save in the menu bar.

Tab. 5.6:	 Menu items in the project tree context menu
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Edit measurement details This menu item appears with the elements Plane / Caustic / Series.
Calls up a toolbench for the purpose of editing measurement details.

Proceed as follows:
1.	 Call Delete in the context menu of the element in question.

	Editable measurement details appear in a tab.
2.	 Edit a value.
3.	 Confirm by pressing the Enter key.
4.	 If required, edit further values.
5.	 If required, save the higher-level project by clicking on it and selecting 

File > Save in the menu bar.

Remeasure This function appears for the elements Plane / Caustic, when a device is 
connected. 
Further information can be found in Chapter  “Remeasuring a caustic or a 
plane” on page 24.

Recalculate Recalculates a measurement. This is relevant when a parameter is changed 
(e.g., ROI, wavelength).

New project Creates a new, empty project when the mouse cursor is hovered above the 
empty space below a project tree.

New series Creates a new, empty series in a project that has been selected in the 
Projects tab.

New caustic Creates a new, empty caustic in a series that has been selected in the 
Projects tab.
This presupposes that the series already contains at least one caustic.

Merge projects Merges all open projects into one single project (see Chapter  “Set options” 
on page 8).

Sort Sorts the sub-elements of a selected element according to a named 
criterion.

Reverse sorting Reverses the order in which the sub-elements of the selected element have 
been sorted.

Rename Alters the name field of the element to write mode.

Proceed as follows:
1.	 Call up menu item in the context menu of the element in question.

	In write mode, the element name appears in a frame and against a blue 
background.

2.	 Write over the former name.
3.	 Confirm by pressing the Enter key.

Tab. 5.6:	 Menu items in the project tree context menu
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Remeasuring a caustic or a plane

When remeasuring a caustic, the existing measurement data are not overwritten. Instead, an additional 
caustic measurement is added to the project tree. When remeasuring a plane, LDS asks whether the plane 
selected in the project tree should be overwritten. 

Proceed as follows  
(e.g., caustic measurement):

1.	 Click on the Projects tab.

2.	 In the project tree, click on the caustic 
measurement that is to be remeasured.

3.	 Select the context menu and the 
menu item Remeasure.

	The settings of the selected 
measurement are applied and 
displayed in the Device control menu.

4.	 Start the measurement as described 
in the device operating manual.

	The progress of the remeasurement is 
shown in the status display.

5.	 After measurement has been 
completed,click on the
End remeasuring button in the 
Advanced tab.
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5.4.7	 Key combinations in the project tree

Key combination Function

F1 Opens the LDS operating manual in a new window. The manual opens at the 
relevant chapter.

F2 Alters the name field of the selected element to write mode.
The element can now be renamed:

1.	 Write over the former name.
2.	 Confirm by pressing the Enter key.

Delete Deletes a selected element from a project tree The asterisk icon * appears 
next to the name of the higher-level element.

	X If required, save the higher-level project by clicking on it and selecting 
File > Save in the menu bar.

Ctrl + O Opens a Windows Explorer window for the purpose of opening a file with 
the LDS file extensions:

•	 .lpf (LDS 1.3.1)
•	 .foc (LDS 2.98)

This file contains an LDS project. The file is loaded into the Projects tab.

Ctrl + S Opens a Windows Explorer window for the purpose of saving a file with the 
LDS file extension .lpf.

This file contains the LDS project that has been selected in the Projects tab.

Ctrl + A Selects all the elements of a project tree.

Crtl + V Inserts an element from the clipboard as a sub-element of the selected 
element.
This presupposes that the element to be inserted is compatible with the 
higher-level element

Crtl + X Deletes the selected element and moves it to the clipboard.

Crtl + Y Repeats the previous action (move, delete, rename).

Crtl + Z Reverses the previous action (move, delete, rename).

Tab. 5.7:	 Key combinations in the project tree
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5.5	 The menu bar

The menu bar is at the top of the user interface. The menu items provide a wide range of control functions 
and settings. 
In order to select a menu item, proceed as follows:
1.	 Click on the menu name in order to display the corresponding menu items. The name of the selected 

menu then appears in inverted form.
2.	 If required, move the mouse cursor over the other menus in order to view their menu items.
3.	 Click on a menu item in order to select it. The name of the selected menu then appears in inverted form.

Menu bar

Selected menu Selected menu item

Fig. 5.6:	 Menu bar, menus and menu items

Menu items in the File menu

Open Opens a Windows Explorer window for the purpose of opening a file with the LDS 
file extensions:
•	 .lpf (LDS 1.3.1)
•	 .foc (LDS 2.98)
This file contains an LDS project. The file is loaded into the Projects tab.

Selectively open Opens a Windows Explorer window for the purpose of opening a project file with 
the LDS extension .lpf (LDS 1.3.1).
When a partial project is selected in a preview dialog window, this partial project is 
then opened in the project tree.
This function makes it easier to handle very large projects.

Save Saves changes to a project that is selected from the Projectstab and which has 
already been saved.
If the selected project has never been saved, see menu item Save as.

Save as Opens a Windows Explorer window for the purpose of saving a file with the LDS file 
extension .lpf.
This file contains the LDS project that has been selected in the Projects tab.

PDF export Opens a Windows Explorer window for the purpose of saving a file with the file 
extensions:
•	 .pdf
•	 .png 

This file contains a report for the measurement that has been selected in the Projects tab.

Before saving a measurement report, select the required document template (report 
template) from a drop-down list. Different templates are available depending on the 
type of measurement.

CSV export Opens a Windows Explorer window for the purpose of saving a file with the file 
extension .csv. 
This file contains the numerical data of the measurement that has been selected in 
the Projects tab.

Files most recently loaded Opens a list of the files most recently loaded (max. 10 files).

Tab. 5.8:	 Overview of the menu items in the menu bar
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Imported settings Opens a Windows Explorer window for the purpose of opening a file with the LDS 
extension .lof. 
This file contains settings that are imported into the Extras > Options menu.

Exported settings Opens a Windows Explorer window for the purpose of saving a file with the LDS file 
extension .lof.
The settings from the Extras > Options menu are saved in this file.

Quit Quits the program.

Menu items in the Connections menu

Connect Opens the Connections window with all located devices.

Disconnect Disconnects the device selected in the Devices tab.

Menu items in the Measurement environment menu

Metadata Opens a toolbench of the same name for viewing metadata in tabular form. 
	X Click on the project tree item in question and drag it into the toolbench window 

while pressing down the left mouse button. 
	Metadata cannot be displayed for all project tree items. In this case, a prohibited 
sign appears in the position of the mouse cursor.

Limit values Opens a toolbench of the same name for configuring global limit and warning values.
Further information can be found in Chapter 8.2.1 “Limit and warning values” on 
page 140.

Menu items in the Tools menu

Contains a listing of all tools in alphabetical order. Clicking on a tool name opens the corresponding tool in a toolbench 
of the same name.
Information on all tools can be found in Chapter 6 “Show and evaluate measurements” on page 37.

New toolbench Creates a new, empty toolbench in a toolbench group.

Toolbenches > This menu item only appears when toolbenches have already been saved. 

Opens a list of saved toolbenches. Clicking on an item in this list opens the 
corresponding toolbench.

Toolbenches as windows Creates free-floating toolbench groups from the toolbenches in the main window.

Toolbenches as tabs Arranges the free-floating toolbench groups as tabs in the main window.

Manage toolbenches Opens the Manage toolbenches menu (see Chapter 5.6.3 on page 33).

Menu items in the Extras menu

Options Here, global settings can be made in the Software, Device, Plug-ins and 
Measurement tabs. 
Further information can be found in Chapter “Global settings in the Extras > Options 
menu” on page 28.

Menu items in the Help menu

Instruction manuals Opens a selection of operating manuals, including the current manual and PRIMES 
measuring device operating manuals. Clicking on a title opens the corresponding 
manual.

Beam information Opens a window with information on the coordinate systems in use, the beam 
parameters and the evaluation algorithms.
Further information can be found in Chapter 7 “Fundamentals of beam geometry 
analysis with LDS” on page 132.

List of key formulas Opens a PDF that explains the key formulas for beam measurement.

About Opens a window containing licenses and information on the version number and 
copyright of LDS.

Tab. 5.8:	 Overview of the menu items in the menu bar
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Global settings in the Extras > Options menu

In the Extras > Options menu, global settings can be made in several tabs. 

The Tools tab lists various tools. If the check box of a tool is disabled, then the tool does not appear in the All 
tools toolbar. The toolbar is displayed in the main window of the user interface (see Chapter 5.6 on page 30). 

The Plug-ins tab lists installed plug-ins

Option (Software tab) Function

Basic settings

Show start screen The start screen appears each time the software is restarted.

Show tutorial Activates the tutorial. The tutorial provides brief instructions, on a blue background, 
about the basic operating steps.

Automatic search for update Activates automatic notification of software updates.

Color contrast Color contrast can be adjusted via a slider or numerically (-1 to 2).

Anti-aliasing Prevents distortion artifacts in 3D images.

Standard algorithm The algorithm for radius calculation can be preselected in a drop-down list. If a tool 
with a drop-down list for algorithm selection is opened, then the standard algorithm 
is set as default in the list (e.g., in the Caustic analysis tool; see Chapter 6.3.6 on 
page 97).

Display parameters for 
selected caustic algorithm 
only

Deactivates the drop-down list for algorithm selection in the relevant tools. These 
tools will then use the standard algorithm for radius calculation.

Standard false-color palette The false-color palette can be preselected in a drop-down list. If a tool with a  
drop-down list for the selection of the false-color palette is opened, then the 
standard palette is set as default in the list (e.g., in the False-color view tool;  
see Chapter 6.3.1 on page 69).

Adaptive tool selection The selection in the All tools toolbar is automatically adjusted. Only those tools that 
match the connected measuring devices and the loaded data types are displayed.

Open measurement 
toolbench

Opening a measuring mode automatically opens a customized toolbench.

The toolbench is displayed in the main window of the user interface and contains 
the most important tools for display and evaluation of measurement results.

Display script console Opens the script console. Outputs from the script can be displayed here.

Automatic update rate in ms The interval for the automatic update of windows can be entered numerically.

Compression for project files Choose in a drop-down list between different levels of compression for saving 
project files.

Use SI units Values are displayed in SI units.

Temperatures in Fahrenheit Temperature values are displayed in Fahrenheit.

Evaluation settings

ROI fill factor The ROI fill factor can be entered numerically. 
A value of 0.5 is set as default. After each new start of LDS, the ROI value is reset 
to 0.5.

Further information on the ROI fill factor is available in the chapter“Fill factors” on 
page 136.

Use ROI The value entered for the ROI fill factor is applied when calculating the 
measurement data.

Tab. 5.9:	 Global settings in the Extras > Options > menu, Software tab
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Option (Software tab) Function

Export settings for plane data

Automatic CSV export Each time a project is saved, a file of the same name with the extension .csv is also 
automatically saved to the selected location.
This file contains the numerical measurement data of all the planes contained in the 
project.

Localized decimal separator 
for CSV export

The decimal separator for CSV export is selected in line with the country setting for 
the operating system.

Separator for CSV export The separator for CSV export can be selected in a drop-down list.

Export raw data as power 
density values

Raw data from the analog-to-digital converter (in cts = counts) are converted to 
power density (kW/cm²) during export. 
This presupposes that a power value was entered or measured during the measurement.

Add color legend to image 
export

During image export, a color legend is added with the corresponding color counts.

Communication

Display connected devices 
only

This ensures that the Connections window displays only those Bluetooth devices 
that are actually connected. 
If not, devices that are not currently connected but were connected at an earlier 
time are also displayed.

Log device communication Device communication is logged in the file lds_log. This file is saved in the directory 
C:\Temp.

Record device status values The device status (e.g., axis travel) is logged in the file lds_log. This file is saved in 
the directory C:\Temp.

Additional settings for remote connections

Directory for setting files Directory path for the settings files that are used for data transfer according to the 
OPC UA automation standard.

Empty the project tree when 
disconnecting a device

The project tree is emptied when the device is disconnected via an automatic 
command.

OPC server address OPC address with which a connection is to be established.

Device IP address Device IP address to establish connection.

Device initialization time in s Time until device is ready for operation. The device can be operated only once this 
time has elapsed.

Tab. 5.9:	 Global settings in the Extras > Options > menu, Software tab

Option (Measurement tab) Function

Remeasure: Adjust 
measurement settings

When remeasuring a plane, the device control settings are reset (e.g., beam search, 
exposure, size of measurement window). Otherwise, the settings from the selected 
measurement are applied.
Further information can be found in Chapter “Remeasuring a caustic or a plane” on page 24.

Only with installed plug-in algorithms for radius calculation

Calculate 1st/2nd power 
inclusion

The 1st/2nd power inclusion is calculated according to the percentage values in the 
fields below.

1st power inclusion in % The percentage value for the calculation of the 1st power inclusion can be entered 
numerically.

2nd power inclusion in % The percentage value for the calculation of the 2nd power inclusion can be entered 
numerically.

Tab. 5.10:	 Global settings in the Extras > Options > menu, Measurement tab
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5.6	 Main window

Measurement data can be displayed and analyzed in the main window of the user interface. A variety of tools 
are available for this purpose, all of which can be displayed in separate windows.
For additional clarity and flexibility, these tool windows can be displayed in any number of toolbenches.

5.6.1	 Structure of main window

Context menu for 
toolbench tab

Drop-down list for 
active toolbench

Click on tab  
to activate

Drop-down list for 
active tool

To cascade  
tool window 

To tile  
tool windowDrop-down list: 

Toolbars

Close toolbench

Add new toolbench

Click on icon 
to open

Click on  
tool window  
to activate

Help

Lock
Show 

measurement  
in project tree

Fig. 5.7:	 Structure of main window
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Operating elements Explanation

Toolbench-related When the program is first started, a toolbench appears in the main window. Any 
number of toolbenches can be added and individually named. The toolbenches are 
arranged as tabs in the main window. The active toolbench comes to the foreground.
In the main window, the following control options are available:

Add a new toolbench:
	X Click on the plus symbol next to the toolbench tabs.

Close a toolbench:
	X  Click on the cross symbol in the toolbench tab.

To activate a toolbench:
The following options are available:

	X Click on the toolbench tab.
	X Select the toolbench from a drop-down list of open toolbenches.
	X Hold down the Ctrl key and press the Tab key repeatedly.

	The active toolbench comes to the foreground.
Open the context menu of a toolbench:

	X Right-click on the toolbench tab.  
Further information can be found in Chapter 5.6.2 “Context menu in the 
toolbench tab” on page 32.

Note also the options in the Toolbenches menu (see Chapter 5.5 “The menu bar” on 
page 26).

Tool-related In a toolbench, the following control options are available:
Select a toolbar:

	X Select a group from the drop-down list. Tools are thematically grouped in 
toolbars.

Opening a tool:
	X Click on the corresponding icon in the toolbar.

For cascaded/tiled arrangement of tool windows:
	X  Click on the corresponding frame icon.

To activate a toolbench:
The following options are available:

	X Click on the tool window.
	X Select the tool window from a drop-down list of open tools.

	The active tool comes to the foreground.
To lock/unlock the contents of a tool window:

	X Click on the lock icon. 

Calling up help for a tool:
The following options are available:

	X Click on the question mark.
	X Hover the mouse cursor over the tool window (but not over the header) and 

press the F1 key.
	The LDS operating manual then appears in a new window. The manual is open 
at the chapter for the tool in question.

Marking the measurement data displayed in a tool in the project tree:
	X Click on the flag icon.  

With this function, the measurement data displayed can be clearly identified in 
the project tree. This improves readability when a lot of tool windows are open in 
one toolbench simultaneously.

Note also the alphabetic listing of tools in the Tools menu (see Chapter 5.5 “The 
menu bar” on page 26).

Tab. 5.11:	 Control functions in main window
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5.6.2	 Context menu in the toolbench tab

Option Explanation

Close tab Closes the corresponding toolbench.

Close other tabs Closes all open toolbenches except from the one in use.

Close all tabs Closes all open toolbenches. A new, empty toolbench is created in the 
main window.

Window Detaches the toolbench from the tab and places it in a movable window.

New horizontal tab group Creates a new horizontal toolbench group

New vertical tab group Creates a new vertical toolbench group

Duplicate tabs Creates an identical toolbench of the same name within a toolbench group.
The number, arrangement and size of the tool windows are also replicated.

Manage toolbenches Opens the Manage toolbenches menu (see Chapter 5.6.3 on 
page 33).

Change tab name Calls up a window in which the name of the relevant toolbench can be 
changed.

Limit values Opens a toolbench of the same name for configuring global limit and 
warning values.
Further information can be found in Chapter 8.2.1 “Limit and warning 
values” on page 140.

Export graphic (.png) Opens a Windows Explorer window for the purpose of saving a file with 
the file extension .png.
This file contains an image of the toolbench in question.

Copy graphic Copies an image of the toolbench in question to the clipboard.

Tab. 5.12:	 Context menu options in the toolbench tab
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5.6.3	 Managing and loading toolbenches

A custom toolbench configuration can be saved as a file with the extension .xml at 
C:\ProgramData\Primes\LDS\customcontrols and loaded from there. This makes it easier to efficiently 
process recurring analysis tasks.

Saving a toolbench

1.	 Click on the workbench tab to activate 
the workbench to be saved.

2.	 Open the menu Manage toolbenches 
via the context menu of the 
toolbench tab or via the main menu 
Toolbenches > Manage toolbenches.

3.	 Enter a file name and a title.
4.	 Click on the button Save toolbench.

Delete a toolbench

1.	 Open the menu Manage 
toolbenches via the context 
menu of the toolbench tab or via 
the main menu Toolbenches > 
Manage toolbenches.

2.	 Open the drop-down list.
3.	 Click on the toolbench to be deleted.
4.	 Click on the button Delete toolbench.

Loading a toolbench

1.	 In the main menu, select 
Toolbenches > Toolbenches.

2.	 Click on the name of the toolbench to 
be loaded.
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5.6.4	 Arranging the main window

By default, the main window contains only one toolbench group. For additional clarity and flexibility, tools 
can be divided into any number of toolbench groups. These can be placed either in a movable window or 
arranged as tiles.

Fig. 5.8:	 Main window with a toolbench group

Fig. 5.9:	 Main window with a movable toolbench group

Fig. 5.10:	 Main window with tiled toolbench groups
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Create a movable toolbench group

1.	 Click on a toolbench tab.
2.	 Hold down the left mouse button and 

drag the tab until a movable window 
appears and, in some cases, a 
positional cross.

3.	 Position the mouse cursor anywhere 
on the screen – but not over the 
positional cross.

4.	 Release the left mouse button when 
the window is positioned the way it is 
wanted.

Create tiled toolbench groups

1.	 Create a movable toolbench group as 
described above.

2.	 Click on the header of the movable 
toolbench group.

3.	 Hold down the left mouse button and 
drag the cursor over the toolbench 
group until a positional cross appears.

4.	 Press and hold the left mouse button 
and position the mouse cursor above 
the positional cross – but not over its 
midpoint.

	The toolbench group divides in two. 
The size and position of the newly 
created group is shown as a white 
area with a blue frame.

5.	 Release the left mouse button when 
the tile is positioned the way it is 
wanted.

6.	 To create more toolbench groups, 
repeat this process.
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To add a toolbench to the tab of a 
toolbench group

1.	 Create a movable toolbench group as 
described above.

2.	 Click on the header of the movable 
toolbench group.

3.	 Hold down the left mouse button and 
drag the cursor over the toolbench 
group until a positional cross appears.

4.	 Press and hold the left mouse button 
and position the mouse cursor over 
the midpoint of the positional cross

	The toolbench group is shown as a 
white area with a blue frame.

5.	 When the desired position has been 
achieved, release the left mouse 
button.

6.	 To add more toolbenches to 
toolbench groups, repeat this 
process.

	The toolbench in question has been 
added to the toolbench group tab.
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6	 Show and evaluate measurements

6.1	 General information on the tools of LDS

6.1.1	 Overview of tools

A variety of tools are available in LDS for showing and evaluating measurements. Tab. 6.1 on page 37 
provides an overview of the tools available. 

The background colors mean the following:

Green Tools to show beam geometry data and power data

Red Tools to show beam geometry data

Blue Tools to show power data

Yellow Other tools

Tool Function

Results table Table showing measurement results

Special features:
•	 Simultaneous display of several measurements in one tool window
•	 Selection of any parameter; display in rows or columns
•	 Display of limit value violations by means of colored markers

Detailed information can be found in Chapter 6.2.1 on page 44.

Graph Display of measurement results as graphs in a coordinate system

Special features
•	 Simultaneous display of several measurements in one tool window
•	 Any combination of several measurement parameters for the y-axes
•	 Selection of an x-parameter (including index, measurement duration and 

timestamp)
•	 Axes divisible with respect to measurement parameters and measurement
•	 Axes independently movable and scalable

Detailed information can be found in Chapter 6.2.2 on page 46.

Measurement value display Display of measurement parameters as single values in numerical form or on 
arc, linear or thermometer scale

Special features: 
•	 Particularly suited for displaying a running measurement
•	 Display of limit value violations by means of colored markers

Detailed information can be found in Chapter 6.2.3 on page 50.

Histogram Graphical display of categorized data

Special features: 
•	 Simultaneous display of several measurements in one tool window
•	 X-axis: equal category width (per measurement)
•	 Y-axis: shows frequencies 

Detailed information can be found in Chapter 6.2.4 on page 53.

Tab. 6.1:	 Overview of tools and their functions
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Tool Function

Graphic data analysis Display of measurement results as graphs in a coordinate system

Special features:
•	 Simultaneous display of several measurements in one tool window
•	 View dependencies between any measurement parameters by selecting 

several y-parameters and one x-parameter
•	 Axes divisible with respect to measurement
•	 Axes independently movable and scalable
•	 Display of limit value and warning values in the coordinates window

Detailed information can be found in Chapter 6.2.5 on page 56.

Evaluation traffic light Review of freely selectable parameters compared to limit and warning values, 
with result shown by a traffic light system.

Special features:
•	 Traffic light or tabular view
•	 Particularly suited for displaying a running measurement

Detailed information can be found in Chapter 6.2.6 on page 62.

Series analysis Evaluation of large data volumes (several series or caustics)

Special features:
•	 Graphical and tabular display
•	 Any combination of several measurement parameters for the y-axes
•	 Selection of an x-parameter (including index duration and timestamp)
•	 Axes independently movable and scalable

Detailed information can be found in Chapter 6.2.7 on page 64.

False-color view Gradated false-color view of power density distribution

Detailed information can be found in Chapter 6.3.1 on page 69.

Plane analysis Graphical and tabular display of a plane

Special features:
•	 Gradated false-color view of power density distribution with movable 

x‑cross sections / y‑cross sections
•	 Tabular display of all measurement results
•	 Review of the validity of a measurement, visually supported by colored 

markers

Detailed information can be found in Chapter 6.3.2 on page 74.

3D plane display Three-dimensional display of power density distribution, rotatable through all 
spatial axes

Detailed information can be found in Chapter 6.3.3 on page 83.

Power inclusion Calculation of the radius of a measuring plane at any given power inclusion 
(and vice versa) 

Special features:
•	 Graphical and numerical display of results
•	 Simultaneous display of several measurements in one tool window

Detailed information can be found in Chapter 6.3.4 on page 86.

Tab. 6.1:	 Overview of tools and their functions
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Tool Function

Beam symmetry analysis Graphical and tabular display of the different power inclusion levels of one plane

Special features: 
•	 Graphical display, linear or polar
•	 Adjustment of circle contours/histograms for better evaluation of beam 

symmetry

Detailed information can be found in Chapter 6.3.5 on page 91.

Caustic analysis Graphical and tabular display of a caustic

Special features:
•	 Graphical display of the measured planes as caustic cross sections  

(false-color views) and caustic longitudinal section
•	 Tabular display of all measurement results
•	 Review of the validity of a measurement, visually supported by colored 

markers
•	 Comparison of the measured values with a reference caustic
•	 Linking to open tools for the purpose of plane display: automatic 

application of the selected plane in the display of these tools

Detailed information can be found in Chapter 6.3.6 on page 97.

3D caustic display Colored, three-dimensional display of a caustic

Special features:
•	 View can be rotated through all spatial axes
•	 Caustic planes in false colors

Detailed information can be found in Chapter 6.3.7 on page 107.

Process volume Display of z‑section of a caustic at given minimum intensity (process volumes)

Special features:
•	 Tabular display 
•	 Comprehensive graphical display (graph, beam symmetry, 3D view)

Detailed information can be found in Chapter 6.3.8 on page 110.

Focus shift Graphical and numerical evaluation of a series of caustics in respect of a focus shift

Detailed information can be found in Chapter 6.3.9 on page 114.

Raw beam analysis Graphical and tabular display of the results of raw beam back calculation  
(only with LaserQualityMonitor LQM+)

Detailed information can be found in Chapter 6.3.10 on page 118.

Beam pointing stability Display of monitor beam pointing stability (only with camera-based measuring 
devices )

Detailed information can be found in Chapter 6.3.11 on page 122.

Preventive maintenance Predictive calculation of when limit values will be reached (based on a trend 
analysis of previous measurement results)

Special features:
•	 Any parameters can be selected
•	 Suitable for large data volumes (series)

Detailed information can be found in Chapter 6.3.12 on page 126.

Tab. 6.1:	 Overview of tools and their functions
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Tool Function

SFM analysis Display of measurements with ScanFieldMonitor SFM

Further information can be found in the device operating manual.
SFM caustic

SFM delay time

SFM stitching

Power measurement Display of the measurement data of a project tree element 
Power measurement

Special features: 
•	 Graphical and numerical display
•	 Also suited for displaying a running measurement

Detailed information can be found in Chapter 6.4 on page 129.

Script editor This tool has an input field for program code in the scripting language Python. 
This scripting language controls the device. Alternatively, program code can be 
loaded into the tool from a file with a .py extension. 
An explanation of the script commands for device control is available on request.

The script is executed via a Start/Stop button. A script console can be opened 
via the menu Extras > Options > Software. 
Outputs from the script are displayed here.

Tab. 6.1:	 Overview of tools and their functions

Tab. 6.2 on page 41 shows which project tree elements can be displayed in a specific tool. If a project tree 
element is dragged into an incompatible tool, a prohibited sign appears at the position of the mouse cursor.
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Results table          

Graph          

Measurement value display         

Histogram        

Graphic data analysis       

Evaluation traffic light      

Series analysis   
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Plane analysis   

False-color view   

3D plane display  

Power inclusion  

Beam symmetry analysis  

Caustic analysis  

3D caustic display  

Process volume  

Focus shift   

Raw beam analysis  

Beam pointing stability  

Preventive maintenance  

SFM analysis   

SFM caustic  

SFM delay time  

SFM stitching  

Power measurement 

Tab. 6.2:	 Compatibility between project tree elements and tools
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6.1.2	 Opening project tree measurements in tools

The measurements listed in the project tree can be opened in tools in different ways. Some of the options 
shown may be limited to certain project tree elements / tools.

Opening a measurement without a suitable tool being already open

1.	 Activate the toolbench in which the measurement is to be opened.
2.	 Use one of the following options to open a measurement:

	X Click on the measurement in the project tree. Then select Show in the context menu of this 
measurement. 

	X Double-click on the measurement in the project tree.

	 A suitable tool is opened in the active toolbench. The measurement is displayed in this tool.

Drag a measurement into an open tool.

1.	 Activate the toolbench in which the measurement is to be opened.
2.	 Open a suitable tool via the toolbar.

	 If a compatible measurement was clicked in the project tree before opening the tool, this will be shown 
in the tool.

3.	 In the project tree, click on the measurement that is to be opened. 
4.	 Press and hold the left mouse button and drag the measurement into the tool.

	 The measurement is now shown in the tool.

Opening different measurements in a single tool window in order to compare them

In some tools, multiple measurements can be displayed simultaneously.

1.	 Activate the toolbench in which the measurements are to be opened.
2.	 Click on one of the measurements. Press and hold the Crtl key and select further measurements. 

Alternatively, press and hold the Shift key and select successive measurements.
3.	 Open a suitable tool via the toolbar. 

	 The measurements are now shown together in the tool.

Further measurements can be dragged into the open tool:
4.	 Select one or more measurements in the project tree as described above. 
5.	 Then press and hold down the left mouse button, drag the measurement(s) into the tool.

	 A plus symbol appears in the tool.

6.	 Press and hold the left mouse button and drag measurements into the plus symbol until it grows in size.

Opening different measurements in multiple tool windows in order to compare them

If, in a particular tool, only one measurement can be displayed at any one time, it is still possible to compare 
measurements. 

1.	 Activate the toolbench in which the measurements are to be opened.
2.	 Click on one of the measurements. Press and hold the Crtl key and select further measurements. 

Alternatively, press and hold the Shift key and select successive measurements.
3.	 Open a suitable tool via the toolbar. 

	 A tool window is opened for each measurement.

4.	 Arrange the tool windows in such a way that measurements can be easily compared. For this purpose, 
use the  button to tile the tool windows (in the top-right corner of the toolbench).

5.	 If necessary, use the  button (in the top-right corner of the window) to lock the contents of tool 
windows. This prevents the content from being updated as a result of double-clicking on another 
measurement in the project tree.
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Opening a measurement in multiple tool windows in order to compare.

It is also possible to open a measurement in different windows for comparison purposes. This is useful when 
evaluating, for example, a caustic based on different algorithms and then comparing the results.

1.	 Activate the toolbench in which the measurement is to be opened.
2.	 Open a suitable tool repeatedly via the toolbar.

	 If a compatible measurement was clicked in the project tree before opening the tool, this will be shown 
in the tool.

3.	 In the project tree, click on the measurement that is to be opened. 
4.	 Press and hold the left mouse button and drag the measurement into toolbench tab.

	 The measurement is now shown in all the open tool windows.

5.	 Arrange the tool windows in such a way that measurements can be easily compared. For this purpose, 
use the  button to tile the tool windows (in the top-right corner of the toolbench).

6.	 Customize display mode, calculation method etc. in the individual tool windows as required.
7.	 If necessary, use the  button (in the top-right corner of the window) to lock the contents of tool 

windows. This prevents the content from being updated as a result of double-clicking on another 
measurement in the project tree.

6.1.3	 Display running measurements in a tool

Running measurements can be displayed in various tools. In this case, the display is continuously updated.

1.	 Switch on the measuring device and connect it to LDS as described in the device operating manual.
2.	 Activate the toolbench in which the measurement is to be opened.
3.	 Open a suitable tool via the toolbar.
4.	 Select a device function in the tab Devices.
5.	 Press and hold the left mouse button and drag the function into the tool.
6.	 Start the measurement as described in the device operating manual.

	 The measurement is now shown in the tool. The display is continuously updated.
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6.2	 Tools to show beam geometry data and power data

6.2.1	 Results table

This tool displays measurement results in tabular form. It is suitable for displaying all project tree elements.

Multiple project tree elements of the same type can be simultaneously displayed in this tool window 
(see Chapter “Opening different measurements in a single tool window in order to compare them” 
on page 42).

Structure of the tool window

Settings window

Selectable parameters

Table window

Bold:
 minimum/maximum

Legend

Gear icon opens:

Number of measurement points

Fig. 6.1:	 Structure of the Results table tool 

Elements Description

Table window The parameters selected in the settings window are displayed here. Rows and 
columns can be exchanged.

Project tree elements of the same type can be displayed simultaneously. When data 
in the rows/columns are inscribed #1, #2 etc., then a legend can be displayed that 
assigns them to the corresponding project tree elements.

If a displayed value violates a limit value, it is shown with a red background. Further 
information can be found in Chapter 8.2 “Review of parameters with colored 
markers” on page 140.

Minimum/maximum values in the table on display are written in bold.

Whenever the mouse cursor is hovered over the top-right corner of the table window, 
a gear icon appears. This is used to open the settings window.

Settings window The settings window contains options for adjusting the table window and exporting 
data. Further information can be found in Tab. 6.4 on page 45.

Tab. 6.3:	 Elements of the Results table tool
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Settings window

The table below lists all the options in order of appearance.

Option Explanation

Number of decimal places 	X Enter a value in the input field in order to determine the number of 
decimal places.

	x Displayed values are rounded up or down.

Number of points 1.	 Enter a value in the input field in order to determine the maximum 
number of measurement points displayed.

	If, for example, the value 10 is entered, then the last 10 
measurement points in the table are displayed.

2.	 If required, all measurement points can be displayed by entering 0.

Show legend If data from different project tree elements are simultaneously displayed, 
a legend can be shown. This assigns the data to the corresponding 
project tree elements. 

	X  Check the box to show the legend.

Exchange rows/columns 	X Click on this button to exchange rows and columns.

Table export (.csv) 	X Click on this button to save the table in its current state as a file with 
the extension .csv.

List of parameters Parameters can be selected from the category sublists of the parameter 
list on display. The parameter list on display depends on which project 
tree element is open.

The following options are available:

Open/close a category sublist:
	X  Click on the arrow right / arrow down.

Selecting all the parameters of a category sublist:
	X Click on the category sublist.

Selecting a parameter:
	X Click on the required parameter.

Selecting several parameters:
1.	 Click on one parameter, 
2.	 press and hold the Crtl key, and click on further parameters.

Selecting several consecutive parameters:
1.	 Click on the top/bottom parameter.
2.	 Then press and hold the Shift key and click on the top/bottom 

parameter.

Tab. 6.4:	 Options in the settings window for the Results table tool
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6.2.2	 Graph

This tool displays measurement results as a graph in a coordinate system. It is suitable for displaying all 
project tree elements.
The y‑axis is selected via the list of measurement parameters. For the x-axis, different parameters can 
be selected in a separate list (including index, measurement duration, time stamp). This is the essential 
difference to the Graphic data analysis tool, in which the x‑axis is likewise selected via the list of 
measurement parameters (see Chapter 6.2.5 on page 56).

Multiple project tree elements of the same type can be simultaneously displayed in this tool window 
(see Chapter “Opening different measurements in a single tool window in order to compare them” 
on page 42).

Structure of the tool window

Selectable, separately 
displayable parameters

Graph window

Legend

Settings window

Gear icon opens:Axes separately  
scalable/movable

Separate  
x-/y-axes

Graph  
display modes

Selection: x-axis

Fig. 6.2:	 Structure of the Graph tool 
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Elements Description

Graph window Information on the control options in this window can be found in Tab. 6.6 on page 47.

A graph is shown in the coordinates window for each selected parameter / open 
measurement. The selected measurement parameters are plotted on the y-axis. 
For the x-axis, different parameters can be selected in a separate list . A legend can 
be displayed that assigns the displayed graphs to the corresponding project tree 
elements / parameters.

Separate x-axes (per measurement) and y-axes (per measurement/parameter) can 
be displayed in the graph window. These can be moved and scaled independently of 
one another. The axes can also be displayed logarithmically.

Whenever the mouse cursor is hovered over the top-right corner of the graph 
window, a gear icon appears. This is used to open the settings window.

Settings window The settings window contains options for adjusting the graph window and exporting 
data. Further information can be found in Tab. 6.7 on page 48.

Tab. 6.5:	 Elements of the Graph tool

Control options in the graph window

Instead of the right mouse button, the left mouse button can also be used while holding down the Alt key.

Action Procedure

Zoom to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Use one of the following options:

	X Press and hold the right mouse button and drag in the required direction.
	X Use the arrow keys to incrementally move in the required direction.

Center all graphs in the coordinates 
window

	X Double-click on the coordinates window, but not in the immediate 
vicinity of a graph.

	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Display coordinate values at any position 
in a graph

	X Click on the relevant area of the graph. 
	The corresponding information is displayed.

Opening the settings window 1.	 Hover the mouse cursor over the coordinates window until the gear 
icon appears in the top-right corner. 

2.	 Click on the gear icon to open the settings window.

Mark an area along the x-axis Any number of areas can be marked along the x-axis. In this way, 
distances can be measured or fit algorithms applied to individual areas.
To mark distances, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the x-axis. 
4.	 If required, repeat to mark further areas along the x-axis.

Removing a marked area 1.	 Press and hold the Shift key. 
2.	 Click on the area to be removed.

Tab. 6.6:	 Control options in the graph window
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Settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

X-axis 	X Select an x-axis inscription from the drop-down list.

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the graph data in numerical form as a 
file with the extension .csv. 

Export graphic (.png) 	X Click on this button to save the graph in its current state as a 
graphics file with the extension .png.

Copy graphic 	X Click on this button to copy the graph in its current state to the 
clipboard.

Axes Drop-down menu

Separate x-axes (per measurement) and y-axes (per measurement/
parameter) can be displayed in the graph window. Multiple parameters, 
for example, can only be displayed simultaneously on a y-axis if they 
have the same unit of measurement. If not, the y-axis should be divided. 
Separate axes can also be useful when there is a large difference in 
magnitude between displayed parameters/measurements.

The axes can be displayed logarithmically. 
A narrower section of the y-axis can be displayed.

Center 	X Click on this button to center the graphic.
	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Separate x‑axis per measurement 	X Check the box to display separate x-axes per measurement.

Separate y‑axis per measurement 	X Check the box to display separate y-axes per measurement.

Separate y‑axis per parameter 	X Check the box to display separate y-axes per parameter.

Apply y-range 	X Check the box to activate the y‑axis section as defined in the 
y‑section fields.

Y-range 	X In the left/right field, enter the minimum/maximum limit value of the 
y-axis section to be displayed.

Logarithm Drop-down menu for logarithmic display of axes.

A logarithmic display is particularly useful when the range of values spans 
many orders of magnitude. This makes it easier to see correlations in the 
range of small values.

X-axis logarithmic (log10) 	X Check the box to display the x‑axes logarithmically.

Y-axis logarithmic (log10) 	X Check the box to display the y‑axes logarithmically.

Display Drop-down menu

Maximum number of points The maximum number of measurement points displayed can be limited 
in the following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

 
Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position. 

Tab. 6.7:	 Options in the settings window for the Graph tool



LaserDiagnosticsSoftware LDS

49 Revision 03 EN – 02/2023

Option Explanation

Graph list Drop-down menu

Drop-down list:
Line
Line+points
Points

1.	 Select in the drop-down list a global display form for all graphs.
2.	 If necessary, alter the display form of individual graphs using the 

graph list below the graph.

Line width 	X Enter a value in the input field.

Point size The measurement points are displayed as circles, squares, triangles etc.
	X Enter a value in the input field.

Graph list The name of a graph contains the relevant parameter and, if applicable, 
the name of the project tree element and the higher-level project tree 
element.
Determine for each graph if and how it will be displayed in the 
coordinates window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

toggle the display mode.

Fit algorithms Drop-down menu
Fit algorithms can be applied to the entire x-range of a graph as well 
as to individual sub-ranges. The results are displayed by means of fit 
graphs in the coordinates window.
In addition, a table for the numerical display of important fit parameters 
is also displayed. The results are displayed in columns per parameter/
measurement/x-section.
Window size can be altered via a side bar. 
Sub-ranges can be marked or removed as described in Tab. 6.6 on 
page 47.

Graph window Table window

Legend for columns

Side bar

Columns:
parameters/measurements/x-sections

x-range

Trend 	X Check the box to apply trend algorithms.

Averaging 	X Check the box to perform averaging.

Caustic fit 	X Check the box to perform a caustic adjustment.

Wavelength The parameter M² (fit algorithmCaustic fit) is calculated as a function of 
wavelength.

	X Enter a value in the input field.

Tab. 6.7:	 Options in the settings window for the Graph tool
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Option Explanation

List of parameters Parameters can be selected from the category sublists of the parameter 
list on display. The parameter list on display depends on which project 
tree element is open.
The following options are available:
Open/close a category sublist:

	X  Click on the arrow right / arrow down.
Selecting all the parameters of a category sublist:

	X Click on the category sublist.
Selecting a parameter:

	X Click on the required parameter.
Selecting several parameters:
1.	 Click on one parameter, 
2.	 press and hold the Crtl key, and click on further parameters.
Selecting several consecutive parameters:
1.	 Click on the top/bottom parameter.
2.	 Then press and hold the Shift key and click on the top/bottom 

parameter.

Tab. 6.7:	 Options in the settings window for the Graph tool

6.2.3	 Measurement value display

In this tool, measurement parameters are displayed as single values in numerical form or as an analog scale 
(arc, linear or thermometer). This is suitable for displaying all project tree elements (except for Series).

This tool is particularly suited for displaying a running measurement (see Chapter “Display running 
measurements in a tool” on page 43). 

Structure of the tool window

Settings window
Gear icon opens:

Arc scale

Numerical display

Linear scale Thermometer 
scale

Fig. 6.3:	 Structure of the Measurement value display tool 
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Smallest  
measured value

Smallest measured 
value for an  

averaging range

Largest measured  
value for an  

averaging range

Last moving average

Largest  
measured value

Last measured value

Fig. 6.4:	 Analog scale display (e.g., arc ) 

Elements Description

Graph window To toggle between different modes, click on the dots in the top-right corner of the 
measurement value display tool.
The numerical display shows the last measured value / the last moving average of a 
series.

The scale display modes are explained on the basis of an arc display; see Fig. 6.4 on 
page 51 (with display of moving averages).

Settings window The settings window also contains options for specifying the averaged range and for 
selecting the displayed parameter. 

Further information can be found in Tab. 6.9 on page 52.

Tab. 6.8:	 Elements of the Measurement value display tool
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Settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Settings Drop-down menu

Number of averaged points To calculate a moving average, the range in which averaging takes place 
must be set.

	X Enter a value in the input field in order to set the number of 
averaged points.

Averaging timespan in s To calculate a moving average, the timespan in which averaging takes 
place must be set.

	X Enter a value in the input field in order to determine the averaging 
timespan.

Number of decimal places This option appears only when the numerical display is selected.

	X Enter a value in order to determine the number of decimal places.
	x Displayed values are rounded up or down.

Font size This option appears only when the numerical display is selected.

	X Enter a value in the input field in order to set the font size of the 
numerical display.

Lock scale If this option is selected, the scale of the measurement value display is 
locked. 
In this case, the scale display modes is no longer automatically adjusted 
when a new measurement is dragged into the tool. 
This makes it easier to compare different measurements.

	X Check the box to activate this option.

List of parameters Parameters can be selected from the category sublists of the parameter 
list on display. 
The parameter list on display depends on which project tree element is 
open.

The following options are available:

Open/close a category sublist:
	X  Click on the arrow right / arrow down.

Selecting a parameter:
	X Click on the required parameter.

Tab. 6.9:	 Options in the settings window for the Measurement value display tool



LaserDiagnosticsSoftware LDS

53 Revision 03 EN – 02/2023

6.2.4	 Histogram

In this tool, measurement data are categorized in a coordinates window. This tool is suitable for 
displaying the following project tree elements: Series, Caustic, Power measurement, Cube series and 
Cube measurement.

Multiple project tree elements of the same type can be simultaneously displayed in this tool window 
(see Chapter “Opening different measurements in a single tool window in order to compare them” 
on page 42).

Structure of the tool window

Graph window

Selectable parameters

Number of 
categories

Gear icon opens:

Legend for multiple measurements

Settings window

Fig. 6.5:	 Structure of the Histogram tool 

Elements Description

Graph window Information on the control options in this window can be found in Tab. 6.11 on page 54.

If several measurements are displayed in the tool simultaneously, then a legend can 
be displayed that assigns the squares to the measurements.

In the coordinates window, the x-axis shows the categories (with equal width per 
measurement), and the y-axis shows their frequency.

Whenever the mouse cursor is hovered over the top-right corner of the graph 
window, a gear icon appears. This is used to open the settings window.

Settings window The settings window contains options for adjusting the graph window and exporting 
data. 
Further information can be found in Tab. 6.12 on page 55.

Tab. 6.10:	 Elements of the Histogram tool



LaserDiagnosticsSoftware LDS

54 Revision 03 EN – 02/2023 

Control options in the graph window

Instead of the right mouse button, the left mouse button can also be used while holding down the Alt key.

Action Procedure

Zoom to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Use one of the following options:

	X Press and hold the right mouse button and drag in the required 
direction.

	X Use the arrow keys to incrementally move in the required direction.

Center all squares in the coordinates 
window

	X Double-click on the coordinates window.

	The axes are moved and scaled so that the squares completely fill 
the coordinates window in all directions. 

Show the coordinate values of a square 	X Click and hold on the square. 

	The corresponding information is displayed.

Opening the settings window 1.	 Hover the mouse cursor over the coordinates window until the gear 
icon appears in the top-right corner. 

2.	 Click on the gear icon to open the settings window.

Mark an area along the x-axis Any number of areas can be marked along the x-axis. In this way, 
distances can be measured or fit algorithms applied to individual areas.

To mark distances, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the x-axis. 
4.	 If required, repeat to mark further areas along the x-axis.

Removing a marked area 1.	 Press and hold the Shift key. 
2.	 Click on the area to be removed.

Removing all marked areas 	X Press the Remove selection button in the settings window.

Tab. 6.11:	 Control options in the graph window
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Settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Number of categories

Graph Drop-down menu

Center 	X Click on this button to center the graphic.
	The axes are moved and scaled so that the squares completely fill 
the coordinates window in all directions. 

Remove selection 	X Click on this button to remove all the distances marked in the 
coordinates window. 

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the graph data in numerical form as a 
file with the extension .csv. 

Export graphic (.png) 	X Click on this button to save the graph in its current state as a 
graphics file with the extension .png.

Copy graphic 	X Click on this button to copy the graph in its current state to the 
clipboard.

Display Drop-down menu

Maximum number of points The maximum number of measurement points displayed can be limited 
in the following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position. 

Fit algorithms Drop-down menu

Averaging 	X Check the box to perform averaging.

Graph list Drop-down menu

Drop-down list:
Line
Line+points
Points

1.	 Select in the drop-down list a global display form for all graphs.
2.	 If necessary, alter the display form of individual graphs using the 

graph list below the graph.

Line width 	X Enter a value in the input field.

Point size The measurement points are displayed as circles, squares, triangles etc.

	X Enter a value in the input field.

Graph list Determine for each graph if and how it will be displayed in the 
coordinates window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

toggle the display mode.

Tab. 6.12:	 Options in the settings window for the Histogram tool
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Option Explanation

Logarithm Drop-down menu for logarithmic display of axes.

A logarithmic display is particularly useful when the range of values 
spans many orders of magnitude. 
This makes it easier to see correlations in the range of small values.

X-axis logarithmic (log10) 	X Check the box to display the x‑axes logarithmically.

Y-axis logarithmic (log10) 	X Check the box to display the y‑axes logarithmically.

List of parameters Parameters can be selected from the category sublists of the parameter 
list on display. The parameter list on display depends on which project 
tree element is open.

The following options are available:

Open/close a category sublist:
	X  Click on the arrow right / arrow down.

Selecting a parameter:
	X Click on the required parameter.

Tab. 6.12:	 Options in the settings window for the Histogram tool

6.2.5	 Graphic data analysis

This tool displays measurement results as a graph in a coordinate system. This tool is suitable for displaying 
the following project tree elements: 

•	 Caustic
•	 Series
•	 Power measurement
•	 SFM vector series
•	 SFM delay time
•	 SFM caustic
•	 Absorber measurement
•	 ADC measurement
•	 Cube series
•	 Cube measurement
•	 Focustracker measurement

In this tool, the parameters displayed on the x-axis and y-axis can be freely selected from the list of 
measurement parameters.
In this way, interdependencies between parameters can be observed. 
This is the essential difference to the Graph tool, in which one or more measurement parameters can be 
displayed as a function of the timestamp, the measurement index or power (see Chapter 6.2.2 on page 46).

Multiple project tree elements of the same type can be simultaneously displayed in this tool window 
(see Chapter “Opening different measurements in a single tool window in order to compare them” 
on page 42).
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Structure of the tool window

Graph window Settings window

Gear icon opens:
Axes separately  

scalable/movable

Displayable legend

Selectable parameters:
x-axis: one parameter

y-axis: multiple parameters

Fig. 6.6:	 Structure of the Graphic data analysis tool 

Elements Description

Graph window Information on the control options in this window can be found in Tab. 6.14 on page 58.

A graph is shown in the coordinates window for each selected measurement 
parameter / each open measurement. The first selected measurement parameter is 
plotted on the x-axis; the other measurement parameters are plotted on the y-axis 
(selection with Ctrl + left mouse button). A legend can be displayed that assigns the 
displayed graphs to the corresponding project tree elements / parameters.

In the graph window, separate axes per measurement can be displayed. All axes can 
be moved and scaled independently of one another. The axes can also be displayed 
logarithmically.
Whenever the mouse cursor is hovered over the top-right corner of the graph window, 
a gear icon appears. This is used to open the settings window.

Settings window The settings window contains options for adjusting the graph window and exporting 
data. Further information can be found in Tab. 6.15 on page 59.

Tab. 6.13:	 Elements of the Graphic data analysis tool
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Control options in the graph window

Instead of the right mouse button, the left mouse button can also be used while holding down the Alt key.

Action Procedure

Zoom to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Use one of the following options:

	X Press and hold the right mouse button and drag in the required 
direction.

	X Use the arrow keys to incrementally move in the required direction.

Center all graphs in the coordinates 
window

	X Double-click on the coordinates window, but not in the immediate 
vicinity of a graph.

	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Display coordinate values at any position 
in a graph

	X Click on the relevant area of the graph. 
	The corresponding information is displayed.

Opening the settings window 1.	 Hover the mouse cursor over the coordinates window until the gear 
icon appears in the top-right corner. 

2.	 Click on the gear icon to open the settings window.

Mark an area along the x-axis Any number of areas can be marked along the x-axis. In this way, 
distances can be measured or fit algorithms applied to individual areas.

To mark distances, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the x-axis. 
4.	 If required, repeat to mark further areas along the x-axis.

Removing a marked area 1.	 Press and hold the Shift key. 
2.	 Click on the area to be removed.

Removing all marked areas 	X Press the Remove selection button in the settings window.

Tab. 6.14:	 Control options in the graph window
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Settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Show limit values 1.	 Check the box to show limit values / warning values.
	If limit values / warning values are configured for the selected 
parameters, then these are displayed as dotted red/yellow lines 
(with inscriptions).

2.	 If necessary, zoom out of the display to see limit values / warning 
values.

Separate x-axes/y-axes per 
measurement

In the graph window, separate x-axes /y‑axes can be displayed per 
measurement. Separate axes can be useful when there is a large 
difference in magnitude between displayed measurements.

	X Check the box to display separate x-axes/y-axes per measurement.

Graph Drop-down menu

Center 	X Click on this button to center the graphic.
	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Remove selection 	X Click on this button to remove all the distances marked in the 
coordinates window. 

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the graph data in numerical form as a 
file with the extension .csv. 

Export graphic (.png) 	X Click on this button to save the graph in its current state as a 
graphics file with the extension .png.

Copy graphic 	X Click on this button to copy the graph in its current state to the 
clipboard.

Display Drop-down menu

Maximum number of points The maximum number of measurement points displayed can be limited 
in the following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

 
Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position.

Tab. 6.15:	 Options in the settings window for the Graphic data analysis tool
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Option Explanation

Fit algorithms Drop-down menu

Fit algorithms can be applied to the entire x-range of a graph as well 
as to individual sub-ranges. The results are displayed by means of fit 
graphs in the coordinates window.

In addition, a table for the numerical display of important fit parameters 
is also displayed. The results are displayed in columns per parameter/
measurement/x-section.

Window size can be altered via a side bar. 

Sub-ranges can be marked or removed as described in
Tab. 6.14 on page 58.

Graph window
Table window

Legend for columns

Side bar

Columns:
parameters/measurements/x-sections

x-range

Trend 	X Check the box to apply trend algorithms.

Averaging 	X Check the box to perform averaging.

Caustic fit 	X Check the box to perform a caustic adjustment.

Wavelength The parameter M² (fit algorithmCaustic fit) is calculated as a function of 
wavelength.

	X Enter a value in the input field.

Graph list Drop-down menu

Drop-down list:
Line
Line+points
Points

1.	 Select in the drop-down list a global display form for all graphs.
2.	 If necessary, alter the display form of individual graphs using the 

graph list below the graph.

Line width 	X Enter a value in the input field.

Point size The measurement points are displayed as circles, squares, triangles etc.

	X Enter a value in the input field.

Tab. 6.15:	 Options in the settings window for the Graphic data analysis tool
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Option Explanation

Graph list The name of a graph indicates the parameter in question.

Determine for each graph if and how it will be displayed in the 
coordinates window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

toggle the display mode.

Logarithm Drop-down menu for logarithmic display of axes.

A logarithmic display is particularly useful when the range of values 
spans many orders of magnitude. 
This makes it easier to see correlations in the range of small values.

X-axis logarithmic (log10) 	X Check the box to display the x‑axes logarithmically.

Y-axis logarithmic (log10) 	X Check the box to display the y‑axes logarithmically.

List of parameters Parameters can be selected from the category sublists of the parameter 
list on display. 
The parameter list on display depends on which project tree element is open.

Proceed as follows:
1.	 Open the desired category sublist by clicking on the arrow to the left 

of the name.
2.	 Click on the parameter for the x-axis.
3.	 Press and hold the Crtl key, and click on one or more parameters 

for the y-axis/y-axes.

Tab. 6.15:	 Options in the settings window for the Graphic data analysis tool
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6.2.6	 Evaluation traffic light

This tools enables a review of freely selectable parameters in respect of limit and warning values. The 
selected parameters are automatically compared with limit and warning values and the result is shown by a 
traffic light system. 
It is possible to toggle between a traffic light and tabular view. This tool is suitable for displaying the following 
project tree elements: Caustic, Plane, Cube measurement and Power measurement.

This tool is particularly suited for displaying a running measurement (see Chapter “Display running 
measurements in a tool” on page 43).
Detailed information on the topic of review is available in the chapter8.2 on page 140.

Structure of the tool window

Settings window

Gear icon opens:

Traffic light view Table view

Selected 
parameters Limit value

Green: no violation
Red: limit value violation

Yellow: warning value violation
Neutral: no value configured

Last measured value  
of a series

Fig. 6.7:	 Structure of the Evaluation traffic light tool 
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Elements Description

Graph window To toggle between different modes, click on the dots in the top-right corner of the 
measurement value display tool. 
The table also appears when the mouse cursor is hovered over the traffic light view.

The traffic light view provides a snapshot review of selected parameters:

Red At least one factory or freely configured limit value has been violated.

Yellow No violation of a limit value, but violation of at least one factory or freely 
configured warning value.

Green No limit or warning values have been violated/configured.

The tabular view shows the last measured value of a series for each selected parameter. 
This enables a direct review of the displayed parameters using background colors.
In this way, it is possible to determine which parameters caused the change in traffic light 
color. In addition, the table lists the limit or warning values for each selected parameter.

Red A factory or freely configured limit value has been violated.

Yellow A factory or freely configured warning value has been violated.

Green The parameter lies within the configured limit or warning values.

Neutral No limit or warning values have been configured.

Settings window The settings window features an option to export tables and parameter lists.

Table export (.csv) 	X Click on this button to save the table in its current state as a file with the 
extension .csv.

List of parameters Parameters can be selected from the category sublists of the parameter list on display. 
The parameter list on display depends on which project tree element is open.

The following options are available:

Open/close a category sublist:
	X  Click on the arrow right / arrow down.

Selecting all the parameters of a category sublist:
	X Click on the category sublist.

Selecting a parameter:
	X Click on the required parameter.

Selecting several parameters:
1.	 Click on one parameter, 
2.	 press and hold the Crtl key, and click on further parameters.

Selecting several consecutive parameters:
1.	 Click on the top/bottom parameter.
2.	 Then press and hold the Shift key and click on the top/bottom parameter.

Tab. 6.16:	 Elements of the Evaluation traffic light tool
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6.2.7	 Series analysis

This table enables the analysis of large data volumes. For this purpose, multiple project tree elements of the 
type Caustic / Series can be simultaneously displayed (see Chapter “Opening different measurements in a 
single tool window in order to compare them” on page 42). 
The data from individual Caustics/Series measurements are mathematically aggregated. Various statistical 
indicators are available for this purpose. The results are shown in graphical and tabular form.

Structure of the tool window

                                

Settings window

Graph window

Selectable, separately 
displayable parameters

Axes separately  
scalable/movable

Table window

Legend

Gear icon opens:

Selection:
x-axis

Statistical indicator

Fig. 6.8:	 Structure of the Series analysis tool

Elements Description

Graph window Information on the control options in this window can be found in Tab. 6.18 on page 65.

A graph is shown in the coordinates window for each selected parameter. 

The selected measurement parameters are plotted on the y-axes. The y-axes can 
be moved and scaled independently of one another. A legend can be displayed that 
assigns the displayed graphs to the corresponding parameters. 

For the x-axis, the parameters Index and Timestamp can be selected in a separate list. 
The index numbering corresponds to the order in which the Caustics/Series are opened 
in the tool.

The axes can also be displayed logarithmically.

Whenever the mouse cursor is hovered over the top-right corner of the graph window, 
a gear icon appears. This is used to open the settings window.

Settings window The settings window contains options for adjusting the graph window and exporting 
data. Further information can be found in Tab. 6.19 on page 66.

Table window The parameters selected in the settings window are displayed numerically here. Rows 
and columns can be exchanged.

Tab. 6.17:	 Elements of the Series analysis tool
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Control options in the graph window

Instead of the right mouse button, the left mouse button can also be used while holding down the Alt key.

Action Procedure

Zoom to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Use one of the following options:

	X Press and hold the right mouse button and drag in the required 
direction.

	X Use the arrow keys to incrementally move in the required direction.

Center all graphs in the coordinates 
window

	X Double-click on the coordinates window, but not in the immediate 
vicinity of a graph.

	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Display coordinate values at any position 
in a graph

	X Click on the relevant area of the graph. 
	The corresponding information is displayed.

Opening the settings window 1.	 Hover the mouse cursor over the coordinates window until the gear 
icon appears in the top-right corner. 

2.	 Click on the gear icon to open the settings window.

Mark an area along the x-axis Any number of areas can be marked along the x-axis. In this way, 
distances can be measured or fit algorithms applied to individual areas.

To mark distances, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the x-axis. 
4.	 If required, repeat to mark further areas along the x-axis.

Removing a marked area 1.	 Press and hold the Shift key. 
2.	 Click on the area to be removed.

Removing all marked areas 	X Press the Remove selection button in the settings window.

Tab. 6.18:	 Control options in the graph window
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Settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

X-axis 	X Select an x-axis inscription from the upper drop-down list.
	X Select a statistical indicator from the lower drop-down list.

Correlation If at least two parameters are selected, the one first selected can be 
displayed on the x-axis.
1.	 Check the box.
2.	 Select the parameter for the x-axis at the bottom of the settings window.
3.	 Select further parameters for the y-axis.

Exchange rows/columns 	X Click on the button to exchange rows and columns in the  
tabular view.

Graph Drop-down menu

Center 	X Click on this button to center the graphic.
	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Remove selection 	X Click on this button to remove all the distances marked in the 
coordinates window.

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the data in numerical form as a file with 
the extension .csv. 

Export graphic (.png) 	X Click on this button to save the graph in its current state as a 
graphic file with the extension .png.

Copy graphic 	X Click on this button to copy the graph in its current state to the 
clipboard.

Display Drop-down menu

Maximum number of points The maximum number of measurement points displayed can be limited 
in the following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

 
Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position. 

Tab. 6.19:	 Options in the settings window for the Series analysis tool
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Option Explanation

Fit algorithms Drop-down menu

Fit algorithms can be applied to the entire x-range of a graph as well 
as to individual sub-ranges. The results are displayed by means of fit 
graphs in the coordinates window.

In addition, a table for the numerical display of important fit parameters 
is also displayed. The results are displayed in columns per parameter/ 
x-section.

Window size can be altered via the side bar. 

Sub-ranges can be marked or removed as described in Tab. 6.18 on 
page 65.

Graph window

Table window

Legend for columns

Side bar

Columns:
parameters/x-sections

x-range

Trend 	X Check the box to apply trend algorithms.

Averaging 	X Check the box to perform averaging.

Caustic fit 	X Check the box to perform a caustic adjustment.

Wavelength The parameter M² (fit algorithmCaustic fit) is calculated as a function of 
wavelength.

	X Enter a value in the input field.

Graph list Drop-down menu

Drop-down list:
Line
Line+points
Points

1.	 Select in the drop-down list a global display form for all graphs.
2.	 If necessary, alter the display form of individual graphs using the 

graph list below the graph.

Line width 	X Enter a value in the input field.

Point size The measurement points are displayed as circles, squares, triangles etc.

	X Enter a value in the input field.

Tab. 6.19:	 Options in the settings window for the Series analysis tool
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Option Explanation

Graph list Determine for each graph if and how it will be displayed in the 
coordinates window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

toggle the display mode.

Logarithm Drop-down menu for logarithmic display of axes.

A logarithmic display is particularly useful when the range of values 
spans many orders of magnitude. This makes it easier to see 
correlations in the range of small values.

X-axis logarithmic (log10) 	X Check the box to display the x‑axes logarithmically.

Y-axis logarithmic (log10) 	X Check the box to display the y‑axes logarithmically.

List of parameters Parameters can be selected from the category sublists of the parameter 
list on display. The parameter list on display depends on which project 
tree element is open.

The following options are available:

Open/close a category sublist:
	X  Click on the arrow right / arrow down.

Selecting all the parameters of a category sublist:
	X Click on the category sublist.

Selecting a parameter:
	X Click on the required parameter.

Selecting several parameters:
1.	 Click on one parameter, 
2.	 press and hold the Crtl key, and click on further parameters.

Selecting several consecutive parameters:
1.	 Click on the top/bottom parameter.
2.	 Then press and hold the Shift key and click on the top/bottom 

parameter.

Tab. 6.19:	 Options in the settings window for the Series analysis tool



LaserDiagnosticsSoftware LDS

69 Revision 03 EN – 02/2023

6.3	 Tools to show beam geometry data

6.3.1	 False-color view

This tool shows a gradated false-color view of power density distribution.

In this tool window, not only the project tree element Plane but also the element Caustic can be 
opened by clicking and dragging. The plane that is closest to the focus is then displayed.
The Linescan element can also be opened. In this case, however, some areas / functionalities of 
the tool differ from the standard plane analysis.
For more information see the chapter “Analysis of a linescan” on page 81.

Structure of the tool window

Settings window

Gear icon opens:

Measure 
distance

Ellipse:
Beam diameter

False-color 
scale

Outside of measurement window:
Measurement area 

In measurement window:
ROI (region of interest)

False-color view:  
Measurement window

Squares:

Coordinates window

Coordinates/amplitude  
at position of reticle

Thick line: reticle

Thin line: main axes

Crosses:

Fig. 6.9:	 Structure of the False-color view tool 

Elements Description

Coordinates window The measuring plane is displayed graphically in the coordinates window. 
The complete measurable area (measurement area in the shape of a square) and the 
area recorded therein (measurement window in false-color view) can be displayed.
Information on the control options can be found in Tab. 6.21 on page 70.

Settings window The options in the settings window enable adjustments to the display, export of 
measurement data and algorithm selection for beam radius calculation. 
Further information can be found in Tab. 6.22 on page 71.

Tab. 6.20:	 Elements of the False-color view tool
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Control options in the coordinates window

Action Procedure

Zooming to the center of the coordinates 
window

1.	 Hover the mouse cursor over the coordinates window until the  
plus/minus buttons appear. 

2.	 Press the buttons for incremental zooming.

Zooming to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel for incremental zooming.

Adjusting zoom area to the size of the 
measurement window

1.	 Hover the mouse cursor over the measurement window.
2.	 Double-click.

	The zoom area is now set to the size of the measurement window.
3.	 To set the zoom area to the size of the measurement area, double-

click once again on the measurement window.

Adjusting zoom area to the size of the 
measurement area

1.	 Hover the mouse cursor outside of the measurement window.
2.	 Double-click.

Moving the entire graphic 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the right mouse button and drag in the required 

direction.

Positioning the reticle 

(e.g., to show coordinates and amplitude 
at any one point)

To position the reticle, select one of the following options:
	X Position the mouse cursor anywhere within the coordinates window 

and click the left mouse button.
	X To continuously change the position of the reticle, drag while holding 

down the left mouse button.
	X To incrementally change the position of the reticle, click on the arrow 

keys.

	The reticle (thick lines) is positioned at this point. The coordinates 
and intensity values are displayed beneath the coordinates window 
if the option Show coordinates is activated in the settings window. 

Measuring a distance To mark a distance, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button. 
3.	 Mark with the mouse.

Removing a marked distance 1.	 Press and hold the Crtl key. 
2.	 Click on the coordinates window.

Tab. 6.21:	 Control options in the coordinates window of the tool False-color view
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Settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Export Drop-down menu

Table export (.csv) 	X Click on this button to save all measurement plane data in numerical 
form as a file with the extension .csv. 

Export graphic (.png) 	X Click on this button to save the coordinates window in its current 
state as a graphics file with the extension .png.

Algorithm The radii are calculated/recalculated according to the algorithm selected. 
Further information on calculation methods can be found in Chapter 7.5 
on page 137.

	X Select an algorithm from the drop-down list:
•	 Device moments:  

Radii are calculated according to the second moment method in the 
device coordinates (x/y). This produces radii in x-/y-orientation. 

•	 Invariant moments:  
Radii are calculated according to the second moment method in the 
device coordinates (x/y). This produces the average of the radii in 
x-/y-orientation.

•	 Rotated moments:  
Following conversion of the device coordinates (x/y) into beam 
coordinates (a/b), the radius calculation is performed according to 
the second moment method. This produces radii in a-/b-orientation.

•	 86%:  
Radii are calculated according to the 86% method. This produces a 
radius.

False-color palette For advanced analysis, different color palettes can be selected. 
Color palettes based on root functions provide a nuanced display of 
signal components with a very low intensity. This can be particularly 
useful when analyzing small variations near the zero level (e.g., for 
analyzing diffraction patterns).

	X Select color palette from the drop-down list:
•	 Linear:  

Linear color palette.
•	 2nd root:  

Color palette based on the second root (colors assigned according 
to the second root of the power density values of each pixel).

•	 4th root:  
Color palette based on the fourth root (colors assigned according to 
the fourth root of the power density values of each pixel).

•	 Grayscale:  
Color palette in grayscale. 

Amplitude in cts 
Intensity in kW/cm²

A threshold value can be set to define a vertical section. ADC values / 
intensity values beneath the threshold are hidden in the false-color view. 
It only makes sense to display intensity when a power value has been 
entered or calculated for the purposes of a measurement.
The ADC value (ADC = analog-digital count) corresponds to the raw 
data from the analog-to-digital converter. This is equal to intensity plus 
the zero level. In some instances, cts (counts) is given as the unit for the 
ADC value.
To set a threshold, select one of the following options:

	X Enter a value in one of the input fields. To confirm, press the Enter 
key.

	X Use the color-palette slider beneath the input fields.
	X Click on the color-palette slider. Move it by pressing the left/right 

arrow keys.

Tab. 6.22:	 Options in the settings window for the False-color view tool



LaserDiagnosticsSoftware LDS

72 Revision 03 EN – 02/2023 

Option Explanation

Lock slider at The color palette slider is used to set a threshold to define a vertical 
section. ADC values / intensity values beneath the threshold are hidden 
in the false-color view. 
The ADC value (ADC = analog-digital count) corresponds to the raw 
data from the analog-to-digital converter. This is equal to intensity plus 
the zero level. In some instances, cts (counts) is given as the unit for the 
ADC value.
The slider can be locked in line with various criteria. This is useful when 
frequently switching back and forth between planes.

	X elect a criterion from the drop-down list:
•	 Power inclusion 86%:  

In the false-color view, starting from the beam center, only the 
values representing 86% of the power inclusion are shown.

•	 Zero level:  
The zero level is the threshold value Only pixels with an ADC value 
above the zero level are shown.

•	 Min. ADC:  
The minimum ADC value is the threshold value.

•	 Current amplitude:  
The ADC value currently entered in the Amplitude in cts input field 
is the threshold value.

•	 Current intensity  
The value currently entered in the Intensity in kW/cm² input field is 
the threshold value.

Center measurement 	X Click this button to set the zoom area to the size of the 
measurement window and to center it.

The measurement window contains this area as a false-color view.

Center measurement area 	X Click this button to set the zoom area to the size of the 
measurement area and to center it.

The measurement area corresponds to the complete measurable area 
(aperture). 

Center on ROI The ROI (region of interest) is the area of the measurement window that 
is used to calculate the beam radius.

	X Click this box to set the zoom area to the size of the ROI and to 
center it.

Show dimensions 	X Check this box to show the calculated diameter.

Show angle 	X Check this box to show the lines representing the beam/device 
main axes.  
If these lines are not visible, click on the measurement area.

Show coordinates 	X Check this box to show the coordinates and intensity values marked 
by the reticle. These are shown beneath the coordinates window.

Coordinate system 	X Check this box to show the x‑axis/y‑axis scale.

False-color scale 	X Check this box to show a false-color scale (in counts). 
	The false-color scale is displayed to the right of the coordinates 
window. 

Black & White This setting gives a binary representation. If the value of a pixel is above/
below the threshold of the color-palette slider, then the pixel is displayed 
in black and white. 

	X Check this box to show the graphic in black and white.

Show ROI The ROI (region of interest) is the area of the measurement window that 
is used to calculate the beam radius.

	X Check this box to show the ROI in the measurement window.

Tab. 6.22:	 Options in the settings window for the False-color view tool
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Linescan display

The element Linescan can also be opened in this tool. A linescan is a repeated scan at short intervals of a 
linear section of a laser beam. Linescans can be performed with measuring devices such as FM+ and BM+.

In this case, however, some elements/functionalities of the tool differ from the standard view. In the following, 
only the aspects specific to the Linescan view are described.

False-color scale  
with line index

Setting options  
for line range

Fig. 6.10:	 A linescan in the tool False-color view

Elements Description

False-color scale  
with line index

In the false-color view, the line index forms the y-axis. 

Setting options  
for line range

This settings window features options to select the line range that is to be displayed:

Range
The following options are available to select the Line range that is to be displayed. 
First, the option Lock range size must be deactivated:

	X Enter the minimum/maximum limit value in the left/right input field. 
To confirm each entry, press the Enter key.

	X Use the sliders beneath the input fields.

Lock range size
	X Check this box to lock the position of the slider.  

If one of the sliders is then moved, the other one will move with it while 
maintaining the set range.

Tab. 6.23:	 Elements of the False-color view tool
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6.3.2	 Plane analysis

This tool shows the results of a plane measurement in graphical and tabular form.

Tables are arranged as tabs in the lower part of the tool window. The area above is divided into quadrants 
that contain graphics and a settings window. The relative size of the quadrants can be altered by dragging 
their edges.

The graph window contains a false-color view and graphs of the x‑cross section/y-cross section. The cross 
sections can be moved using the reticle in the false-color view.

In this tool window, not only the project tree element Plane but also the element Caustic can be 
opened by clicking and dragging. The plane that is closest to the focus is then displayed.
The Linescan element can also be opened. In this case, however, some areas / functionalities of 
the tool differ from the standard plane analysis.
For more information see the chapter “Analysis of a linescan” on page 81.

Structure of the tool window

                                

Table window  
with tabs

Results
Review
Details

Settings window  
for y-cross section

Side bar  
to adjust size

Graph of 
x-cross section

Graph of  
y-cross section

False-color view

Reticle to move 
cross sections

Overall settings 
window

Gear icon opens:

Dotted line: 
Position of slider

Solid line: 
Position of  

linear section

Color palette  
with slider

Fig. 6.11:	 Structure of the Plane analysis tool
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Elements Description

False-color view The false-color view offers the same options as the False-color view tool. 
Further information can be found in Chapter 6.3.1 “False-color view” on page 69. 
The only difference is that with the Plane analysis tool, the reticle is used to move 
the cross sections in an x-/y-direction.

Graphs for  
x-cross section/ 
y-cross section

These coordinates windows display graphs in line with the position of the reticle.

The coordinates windows also contain the following elements:
•	 The dotted orange line shows the position of a vertical section. This 

corresponds to the position of the color-palette slider in the Overall settings 
window. 

•	 The solid line shows the position of an x-cross section/y-cross section.
•	 Whenever the mouse cursor is hovered over the top-right corner of the 

coordinates window, a gear icon appears. This is used to open the settings 
window. 

Information on the control options can be found in Tab. 6.25 on page 76.

Settings:  
Coordinates window 
for x-/y-cross section

This settings window features options for graphically adjusting the coordinates 
window and for exporting the contents of the window. 
Further information can be found in Tab. 6.27 on page 79.

Overall settings 
window

This settings window features options for adjusting the false-color view and cross 
sections. 
Further information can be found in Tab. 6.26 on page 77.

Table window The tables for this area are included in the following tabs:
•	 Results:  

Contains the parameters calculated for a plane.
•	 Review:  

Contains the parameters that enable a review of a plane measurement. The 
review is visually supported by means of colored markers. Further information can 
be found in Chapter “The Review tab in the Plane Analysis tool” on page 80.

•	 Details:  
Contains additional information on a measurement. If comments on a plane 
measurement have been created in the project tree, these are also displayed in 
this tab.

Tab. 6.24:	 Elements of the Plane analysis tool



LaserDiagnosticsSoftware LDS

76 Revision 03 EN – 02/2023 

Control options in the coordinates window for the x-/y-cross sections

Action Procedure

Zooming to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the right mouse button and drag in the required 

direction.

Center graphs for false-color view 	X To center a graph relative to the false-color view, double-click on the 
coordinates window – but not directly adjacent to the graph itself.

	This moves and scales the axis of intensity/amplitude. 

Center graphs in the coordinates window 	X Double-click on graphs. 
	The axes are moved and scaled so that the graph completely fills 
the coordinates window in all directions. 

Display coordinates and amplitude/
intensity at any position in a graph

	X Click on the relevant area of the graph. 

	The corresponding information is displayed. It is only possible 
to display the intensity when a power value has been entered or 
calculated for the purposes of a measurement.

 Opening the settings window 1.	 Hover the mouse cursor over the coordinates window until the gear 
icon appears in the top-right corner. 

2.	 Click on the gear icon to open the settings window.

Positioning a vertical section 1.	 Click on the dotted orange line. 
2.	 Now press the left mouse button and drag along the axis of 

amplitude/intensity or press the corresponding arrow keys.
	The position of the false-color slider in the Overall settings window 
alters correspondingly.

The vertical section can also be positioned by entering a number into 
the input field Amplitude in cts / Intensity in kW/cm² in the Overall 
settings window.

Marking an area along the axis of 
amplitude/intensity

Any number of areas can be marked along the axis of amplitude/intensity 
This serves to measure distances.

To mark distances, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the axis of amplitude/intensity. 
4.	 If required, repeat to mark further areas.

Removing a marked area 1.	 Press and hold the Shift key. 
2.	 Click on the area to be removed.

Removing all marked areas 	X Press the Remove selection button in the settings window.

Tab. 6.25:	 Control options in the coordinates window for the x-/y-cross sections
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Overall settings window

The table below lists all the options in order of appearance.

Option Explanation

Lock slider at The color palette slider is used to set a threshold to define a vertical 
section. ADC values / intensity values beneath the threshold are hidden 
in the false-color view. 

The ADC value (ADC = analog-digital count) corresponds to the raw 
data from the analog-to-digital converter. This is equal to intensity plus 
the zero level. In some instances, cts (counts) is given as the unit for the 
ADC value.

The slider can be locked in line with various criteria. This is useful when 
frequently switching back and forth between planes.

	X Select a criterion from the drop-down list:
•	 Power inclusion 86%:  

In the false-color view, starting from the beam center, only the 
values representing 86% of the power inclusion are shown.

•	 Zero level:  
The zero level is the threshold value Only pixels with an ADC value 
above the zero level are shown.

•	 Min. ADC:  
The minimum ADC value is the threshold value.

•	 Current amplitude:  
The ADC value currently entered in the Amplitude in cts input field 
is the threshold value.

•	 Current intensity  
The value currently entered in the Intensity in kW/cm² input field is 
the threshold value.

Amplitude in cts 
Intensity in kW/cm²

A threshold value can be set to define a vertical section. ADC values / 
intensity values beneath the threshold are hidden in the false-color view. 
It only makes sense to display intensity when a power value has been 
entered or calculated for the purposes of a measurement.

The ADC value (ADC = analog-digital count) corresponds to the raw 
data from the analog-to-digital converter. This is equal to intensity plus 
the zero level. In some instances, cts (counts) is given as the unit for the 
ADC value.

To set a threshold, select one of the following options:
	X Enter a value in one of the input fields. To confirm, press the Enter 

key.
	X Use the color-palette slider beneath the input fields.
	X Click on the color-palette slider. Move it by pressing the left/right 

arrow keys.

Center on ROI The ROI (region of interest) is the area of the measurement window that 
is used to calculate the beam radius.

	X Click this box to set the zoom area of the false-color view to the size 
of the ROI and to center it.

Automatic scaling In the coordinates windows of the graphs, the axis of intensity/amplitude 
can be automatically scaled according to the highest measured value. 
The axes of both coordinates windows are scaled equally, so that the 
displayed graphs are always comparable.

	X Check the box to activate this option.

Tab. 6.26:	 Options in the Overall settings window for the Plane analysis tool
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Option Explanation

Show amplitude 	X Check this box if amplitude (ADC value in counts) rather than 
intensity is to be displayed in the graphs.

It is only possible to display the intensity when a power value has been 
entered or calculated for the purposes of a measurement. 

Show integral In the coordinates windows of the cross sections, the line integral can 
be displayed instead of the power density distribution. This means 
that for each x-value / y-value, the sum of all corresponding y-values / 
x-values is displayed.

Using the line integral, it is easy to identify, for example, any holes in the 
power density distribution. The image below shows the y-line integral for 
a non-Gaussian beam.

Show Gauss 	X Check this box if, in addition to graphs showing power density 
distribution, graphs showing the normal Gaussian distribution are to 
be displayed as well  
For this purpose, a Gaussian distribution is approximated to the 
actual power density distribution according to the smallest error 
square (Gaussian fit).

	Graphs of the power density distribution / line integrals are shown in 
light blue, Gaussian graphs in dark blue. 

Algorithm The radii are calculated/recalculated according to the algorithm selected. 
Further information on calculation methods can be found in Chapter 7.5 
on page 137.

	X Select an algorithm from the drop-down list:
•	 Device moments:  

Radii are calculated according to the second moment method in the 
device coordinates (x/y). This produces radii in x-/y-orientation. 

•	 Invariant moments:  
Radii are calculated according to the second moment method in the 
device coordinates (x/y). This produces the average of the radii in 
x-/y-orientation.

•	 Rotated moments:  
Following conversion of the device coordinates (x/y) into beam 
coordinates (a/b), the radius calculation is performed according to 
the second moment method. This produces radii in a-/b-orientation.

•	 86%:  
Radii are calculated according to the 86% method. This produces a 
radius.

Tab. 6.26:	 Options in the Overall settings window for the Plane analysis tool



LaserDiagnosticsSoftware LDS

79 Revision 03 EN – 02/2023

Settings windows for the coordinates window for the x-/y-cross sections

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Center 	X To center a graph relative to the false-color view, click on this 
button.

Remove selection 	X Click on this button to remove all the distances marked in the 
coordinates window. 

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the graph measurement data in 
numerical form as a file with the extension .csv. 

Export graphic (.png) 	X Click on this button to save the coordinates window in its current 
state as a graphics file with the extension .png. If legends are 
hidden, they are not included in the exported graphic.

Display Drop-down menu

Maximum number of points The maximum number of measurement points displayed can be limited 
in the following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

 
Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position. 

Graph list Drop-down menu

Different graphs are shown depending on the settings selected in the 
Overall settings window. Instead of power density distribution, the 
line integral can be displayed. In addition, the graph of normal Gaussian 
distribution can also be displayed.

Drop-down list:
Line
Line+points
Points

1.	 Select in the drop-down list a global display form for all graphs.
2.	 If necessary, alter the display form of individual graphs using the 

graph list below the graph.

Line width 	X Enter a value in the input field.

Point size The points for power density distribution / line integral are shown as 
circles, the points for the Gaussian graph as squares.

	X Enter a value in the input field.

Cross section / Line integral / Gauss Determine if and how these graphs are to be displayed in the 
coordinates window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

toggle the display mode.

Tab. 6.27:	 Options in the settings window for the x-/y-cross sections of the Plane analysis tool
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The Review tab in the Plane Analysis tool

To ease measurement routines, PRIMES has translated the requirements for an ISO 11146 measurement with 
LDS into individual, easily verifiable parameters. LDS rates the quality of each parameter with a traffic light 
system. 
A red light means that a requirement according to ISO 11146 (or a related requirement pertaining to a 
measurement parameter) has been violated. As the number and severity of parameter violations increases, so 
too does the uncertainty of each measurement. 
If all parameters are green, the measurement can be regarded as reliable and highly accurate.

The values displayed are marked red or green in the table:

•	 Red: one of the limit values factory configured as a criterion of validity has been violated

•	 Green: the limit values specified as a criterion of validity have been met

If one or more of the values displayed is marked red, then a red cross appears next to the title of the tab
(if not, a green check mark appears). 
A red cross indicates that the measurement should be repeated with optimized parameters.

Parameter Explanation

Fill factor (86%) Ratio of beam diameter to width of measurement window. 
If the fill factor is too small, this impacts the resolution of the recorded 
beam. 
If the fill factor is too large, there is a risk that the beam will be clipped. 
The automatic selection of an ROI by the LDS chooses optimal fill factors 
(target value: 0.33).
Lower warning value: 0.30
Upper warning value: 0.60
Upper limit value: 0.75

SNR Signal-to-noise ratio
Lower warning value: 35
Lower limit value: 20

Signal level in % Modulation related to sensor dynamics. Good values are in the range 
40–90.
Lower limit value 10
Upper limit value: 95

Percentage of overdriven pixels in % Permissible number of overdriven pixels (modulation> 95%).
Upper limit value: 0.2

Decentering x/y in % Decentering of the beam’s center of gravity with respect to the 
measurement window.
Upper limit value: 5

# Illuminated pixels in rx / ry A minimum number of pixels in the beam diameter is required in order to 
obtain a reliable measurement value for the diameter.
Lower warning value: 30
Lower limit value: 10

Tab. 6.28:	 Review parameters of the Plane analysis tool

A systematic introduction to this topic and a detailed description of the tools used to review parameters is 
provided in Chapter 8.2 “Review of parameters with colored markers” on page 140.
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Analysis of a linescan

The element Linescan can also be opened in this tool. A linescan is a repeated scan at short intervals of a 
linear section of a laser beam. Linescans can be performed with measuring devices such as FM+ and BM+.

In this case, however, some elements/functionalities of the tool differ from the standard view. In the following, 
only the aspects specific to the Linescan view are described.

                                

False-color scale  
with line index

Setting options  
for line range

Tab:

Single line
Statistics

Graph  
with line index

Fig. 6.12:	 A linescan in the tool Plane analysis
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Elements Description

False-color scale  
with line index

In the false-color view, the line index forms the y-axis. The reticle marks the active line. 
The parameters calculated for the active line can be viewed in the Single line tab.

Graph  
with line index

In the coordinates window, to the right of the false-color view, the y-axis is replaced 
by the line index.

Setting options  
for line range

This settings window features options to determine the line range that is to be 
displayed:

Statistics only for the selected area
	X Check this box if only the values for the selected line range are to be calculated 

in the Statistics tab.

Range
The following options are available to set the Line range that is to be displayed.  
First, the option Lock range size must be deactivated:

	X Enter the minimum/maximum limit value in the left/right input field. 
To confirm each entry, press the Enter key.

	X Use the sliders beneath the input fields.

Lock range size
	X Check this box to lock the position of the slider.  

If one of the sliders is then moved, the other one will move with it while 
maintaining the set range.

Table window This area contains two specific parameters:

•	 Single line contains the parameters calculated for the selected line.
•	 Statistics contains an averaged evaluation for all lines.  

If in the settings window the option Statistics for selected range only is 
activated, then the average will be calculated for this range only.

Tab. 6.29:	 Elements of the Plane analysis tool
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6.3.3	 3D plane display

This tool shows a gradated, three-dimensional false-color view of power density distribution.

In this tool window, both the project tree element Plane and the element itself can be opened 
Caustic by clicking and dragging. This shows the plane that is closest to the focus.

Structure of the tool window

Settings window

Gear icon opens:

False-color 
scale

x-axis/y-axis

Amplitude/intensity

Axes:

Three-dimensional  
false-color view

Graph window

Fig. 6.13:	 Structure of the 3D plane display tool 

Elements Description

Graph window This three-dimensional view can be rotated through all spatial axes and is scalable to 
any size. 
When the mouse cursor is hovered over the graph window, the following controls 
options are available:
Opening the settings window:

	X Click on the gear icon in the top-right corner.
Zooming to the center of the graph window:

	X Turn the mouse wheel.
Rotating the view about its axes:

	X Press and hold the left mouse button and drag the graphic.
Moving the graphic:

	X Press and hold the right mouse button and drag the graphic.
Centering the graphic:

	X Double-click.

Settings window The settings window contains options for adjusting the graph window and exporting 
measurement data. Further information can be found in Tab. 6.31 on page 84.

Tab. 6.30:	 Elements of the 3D plane display tool
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Settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Export Drop-down menu

Table export (.csv) 	X Click on this button to save all measurement plane data in numerical 
form as a file with the extension .csv. 

Export graphic (.png) 	X Click on this button to save the graphic in its current state as a 
graphics file with the extension .png.

False-color palette For advanced analysis, different color palettes can be selected. 

Color palettes based on root functions provide a nuanced display of 
signal components with a very low intensity. This can be particularly 
useful when analyzing small variations near the zero level (e.g., for 
analyzing diffraction patterns).

	X Select color palette from the drop-down list:
•	 Linear:  

Linear color palette.
•	 2nd root:  

Color palette based on the second root (colors assigned according 
to the second root of the power density values of each pixel).

•	 4th root:  
Color palette based on the fourth root (colors assigned according to 
the fourth root of the power density values of each pixel).

•	 Grayscale:  
Color palette in grayscale. 

Amplitude in cts 
Intensity in kW/cm²

A threshold value can be set to define a vertical section. ADC values / 
intensity values beneath the threshold are hidden in the false-color view. 
It only makes sense to display intensity when a power value has been 
entered or calculated for the purposes of a measurement.

The ADC value (ADC = analog-digital count) corresponds to the raw 
data from the analog-to-digital converter. This is equal to intensity plus 
the zero level. In some instances, cts (counts) is given as the unit for the 
ADC value.

To set a threshold, select one of the following options:
	X Enter a value in one of the input fields. To confirm, press the Enter 

key.
	X Use the color-palette slider beneath the input fields.
	X Click on the color-palette slider. Move it by pressing the left/right 

arrow keys.

Center measurement 	X Click on this button to center the graphic.
	This automatically rotates the graphic and scales it to size.

Resolution x/y 	X To determine the resolution of the graphic, enter the required values 
in the relevant input fields. To confirm, press the Enter key.

	If the resolution thereby entered exceeds the resolution set during 
measurement, the latter is automatically selected.

Automatic scaling 	X Check this box if the axis of intensity/amplitude is to be 
automatically scaled according to the highest measured value.

Tab. 6.31:	 Options in the settings window for the 3D plane display tool
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Option Explanation

Intensity scale 	X Check this box to display amplitude (ADC value in counts) rather 
than intensity.

It is only possible to display the intensity when a power value has been 
entered or calculated for the purposes of a measurement.

Aspect correction The x-axis and y-axis can be scaled in such a way as to produce 
a square. This makes it easier to view measurements with a large 
aspect ratio.

	X Check the box to activate this option.

Wireframe view 	X Check this box to display a pixel grid. 

Grid resolution is set according to the values entered in the 
Resolution x/y input fields.

Show axes 	X Check this box to display axes.

False-color scale 	X Check this box to show a false-color scale. This is shown to the 
right of the graphic.

Tab. 6.31:	 Options in the settings window for the 3D plane display tool
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6.3.4	 Power inclusion

In this tool, the radius within a measurement plane can be calculated for any given power inclusion (and vice 
versa). The results are shown in graphical and numerical form.

Application example: Estimation of the power that is cut off by, or still passes through, an aperture of known 
diameter. This can be used, for example, to estimate losses in a beam guidance system or focusing unit.

Multiple measurement planes can be simultaneously displayed in this tool window 
(see Chapter “Opening different measurements in a single tool window in order to compare them” 
on page 42).
In this tool window, both the project tree element Plane and the element itself can be opened 
Caustic by clicking and dragging. This shows the plane that is closest to the focus.

Structure of the tool window

                                

Table window 

X: Radius

Axes:

Y: Inclusion

Result:
1st opened plane

Result:
2nd opened plane

Gear icon opens:

Settings window

Legend

Input:
Inclusion P1/P2

Input:
Radius r1/r2

False-color view

Side bar  
to adjust size

Graphs

White: according to input

Circles:

White: Radius 86.5%

Fig. 6.14:	 Structure of the Power inclusion tool 
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Elements Description

Coordinates window 
for graphs

Control options
Information on the control options in this window can be found in Tab. 6.33 on 
page 88.

Coordinates window
For each measuring plane, a graph is shown in the coordinates window. The radius 
is plotted on the x-axis, the power inclusion on the y-axis. If multiple measurement 
planes are shown in the tool window, a legend can be displayed that assigns the 
graphs to the corresponding project tree elements and to the results columns in the 
table window.

The coordinates window also contains the following inscribed lines (depending on the 
settings): 
•	 Green: Radius at a power inclusion of 86.5% (see Chapter “Radius calculation 

with the 86% method algorithm” on page 137)
•	 Red: Radius / power inclusion according to input P1/r1
•	 Orange: Radius / power inclusion according to input P2/r2

Coordinates window 
for false-color view

Control options
Information on the control options in this window can be found in Tab. 6.34 on 
page 89.

Coordinates window
The measuring plane is displayed graphically in the coordinates window. If several 
planes are open in the tool, the one most recently opened is displayed. The complete 
measurable area (measurement area in the shape of a square) and the area recorded 
therein (measurement window in false-color view) can be displayed.

The coordinates window also contains the following elements (depending on the 
settings): 
•	 White circles: Radius according to input P1/P2 or r1/r2
•	 White circle: Radius at a power inclusion of 86.5% (see Chapter “Radius 

calculation with the 86% method algorithm” on page 137)

Settings window The settings window contains options for adjusting the table window and graph 
windows. Further information can be found in Tab. 6.35 on page 90.

Table window The input values for power inclusion P1/P2 and radius r1/r2 can be entered in the 
rows of the table window.

The results are then shown in the columns. If multiple measurement planes are 
shown in the tool window, a legend can be displayed that assigns the columns to the 
corresponding project tree elements and to the graphs in the coordinates window.

In addition, a beam radius at a power inclusion of 86.5% can be displayed (see 
Chapter “Radius calculation with the 86% method algorithm” on page 137).

Tab. 6.32:	 Elements of the Power inclusion tool
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Control options for graphs in the coordinates window

Instead of the right mouse button, the left mouse button can also be used while holding down the Alt key.

Action Procedure

Zooming to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Use one of the following options:

	X Press and hold the right mouse button and drag in the required 
direction.

	X Use the arrow keys to incrementally move in the required direction.

Center graphs in the coordinates window 	X Double-click on the coordinates window.
	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Display coordinate values at any position 
in a graph

	X Click on the relevant area of the graph. 
	The corresponding information is displayed.

Mark an area along the x-axis Any number of areas can be marked along the x-axis. This serves to 
measure distances.

To mark distances, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the x-axis. 
4.	 If required, repeat to mark further areas along the x-axis.

Removing a marked area 1.	 Press and hold the Shift key. 
2.	 Click on the area to be removed.

Tab. 6.33:	 Control options for graphs in the coordinates window
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Control options for false-color view in the coordinates window

Action Procedure

Zooming to the center of the coordinates 
window

1.	 Hover the mouse cursor over the coordinates window until the  
plus/minus buttons appear. 

2.	 Press the buttons for incremental zooming.

Zooming to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel for incremental zooming.

Adjusting zoom area to the size of the 
measurement window

1.	 Hover the mouse cursor over the measurement window.
2.	 Double-click.

Adjusting zoom area to the size of the 
measurement area

1.	 Hover the mouse cursor outside of the measurement window.
2.	 Double-click.

Moving the entire graphic 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the right mouse button and drag in the required 

direction.

Measuring a distance To mark a distance, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button. 
3.	 Mark with the mouse.

Removing a marked distance 1.	 Press and hold the Crtl key. 
2.	 Click on the coordinates window.

Tab. 6.34:	 Control options for false-color view in the coordinates window
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Settings window

The table below lists all the options in order of appearance. Some options/drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Show beam radius 	X Check this box to show a radius at a power inclusion of 86.5% (see Chapter 
“Radius calculation with the 86% method algorithm” on page 137).

	The radius is shown in the following way:
•	 In the coordinates window for graphs: as a dotted green line 
•	 In the coordinates window for false-color view: as a white circle
•	 In the table window 

Show power inclusion 1.	 Check this box to show power inclusion at a default radius r1/r2.
	The table window is enlarged to include rows for r1/r2.

2.	 Enter a value in the table for radius r1/r2.
3.	 Confirm by pressing the Enter key.

	The power inclusion at r1/r2 is displayed in the coordinates window 
for graphs and in the table window.

Power inclusion P1/P2 in % 1.	 Enter a value for power inclusion P1/P2. Alternatively, enter a value 
in the table.

2.	 Confirm by pressing the Enter key.
	The radius at P1/P2 is displayed in the table and in the coordinates 
window for graphs.

Power inclusion radius 1/2 	X Check this box to show a radius at a power inclusion P1/P2.
	The radius at P1/P2 is displayed in the coordinates window for 
false-color view as a white circle.

Radius 1/2 	X Check this box to show radius r1/r2.
	The radius r1/r2 is displayed in the coordinates window for  
false-color view as a white circle.

Graph Drop-down menu

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the data in numerical form as a file with 
the extension .csv. 

Export graphic (.png) 	X Click on this button to save the graph in its current state as a 
graphics file with the extension .png.

Copy graphic 	X Click on this button to copy the graph in its current state to the clipboard.

Display Drop-down menu

Maximum number of points The maximum number of measurement points displayed can be limited 
in the following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position. 

Graph list Drop-down menu

Line width 	X Enter a value in the input field.

Point size The points are displayed as circles and squares.
	X Enter a value in the input field.

Graph list Determine for each graph if and how it will be displayed in the 
coordinates window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

toggle the display mode.

Tab. 6.35:	 Options in the settings window for the Power inclusion tool
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6.3.5	 Beam symmetry analysis

This tool enables beam symmetry analysis on a measured plane. Contour lines to show the intensity values 
measured for different power densities are generated and approximated by circles. The results are shown in 
graphical and tabular form.

In the graph window, the contour lines are shown together with the approximated circles. Both a polar and 
a linear display can be selected. To aid evaluation of beam symmetry, the statistical deviation of measured 
values from generated values is calculated and displayed in the table window.

In this tool window, both the project tree element Plane and the element itself can be opened 
Caustic by clicking and dragging. This shows the plane that is closest to the focus.

Structure of the tool window

                                

Table window
(with activated circle contour) 

Graph window

Graph settings 
window

Overall settings 
window

Gear icon opens:Gear icon opens:

Displayable 
legend

Graphs:
Measured and adjusted values

Polar representation

Fig. 6.15:	 Structure of the Beam symmetry analysis tool 
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Elements Description

Graph window Information on the control options in this window can be found in Tab. 6.37 on 
page 93.

In the coordinates window, the results of the beam symmetry analysis can be 
displayed in either polar or linear mode.

The following elements may be shown in the graph window (depending on the 
selected settings):
•	 Whenever the mouse cursor is hovered over the top-right corner of the 

coordinates window, a gear icon appears. This is used to open the Graph 
settings window.

•	 Solid lines show the intensity values measured.
•	 Dotted lines show the mathematically approximated circles.
•	 Crosses show two-dimensional centers of gravity (in polar views).
•	 A Legend assigns the graphs to the corresponding power inclusion / minimum 

intensity values.

Overall settings 
window

The Overall settings window features a range of basic options. Further information 
can be found in Tab. 6.38 on page 94.

Graphics settings 
window

The Graph settings window features options for graphically adjusting the coordinates 
window and for exporting the contents of the window. Further information can be 
found in Tab. 6.39 on page 95.

Table window The table window shows the following:
•	 When the option Circle contour / histogram is activated: 

The radii of the mathematically approximated circles and the relative standard 
deviation of the measured intensity values.

•	 When the options Circle contour / histogram and Show center of gravity are 
activated:  
The calculated two-dimensional centers of gravity and their relative deviation with 
respect to the beam center of gravity (calculated according to the first moment 
method; see Chapter “Calculation of beam position” on page 136).

Tab. 6.36:	 Elements of the Beam symmetry analysis tool
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Control options in the graph window

Instead of the right mouse button, the left mouse button can also be used while holding down the Alt key.

Action Procedure

Zooming to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Use one of the following options:

	X Press and hold the right mouse button and drag in the required 
direction.

	X Use the arrow keys to incrementally move in the required direction.

Center all graphs in the coordinates 
window

	X Double-click on the coordinates window, but not in the immediate 
vicinity of a graph.

	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Display coordinate values at any position 
in a graph

	X Click on the relevant area of the graph.
	The corresponding information is displayed.

Opening the graph settings window 1.	 Hover the mouse cursor over the coordinates window until the gear 
icon appears in the top-right corner. 

2.	 Click on the gear icon to open the settings window.

Mark an area along the x-axis Any number of areas can be marked along the x-axis. In this way, 
distances can be measured or fit algorithms applied to individual areas.

To mark distances, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the x-axis.
4.	 If required, repeat to mark further areas along the x-axis.

Removing a marked area 1.	 Press and hold the Shift key.
2.	 Click on the area to be removed.

Removing all marked areas 	X Press the Remove selection button in the Graph settings window.

Tab. 6.37:	 Control options in the graph window
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Overall settings window

The table below lists all the options in order of appearance.

Option Explanation

Drop-down list:
Linear
Polar

	X In the drop-down list, select the required mode of display for  
the graphs.

Drop-down list:
No circle
Circle contour
Histogram

	X Select in the drop-down list whether circles should be mathematically 
approximated – and, if so, according to which method:

•	 No circle:  
No generation of a circle.

•	 Circle contour:  
A circle is approximated with a minimum deviation from the 
contours of the measured values.

•	 Histogram:  
Circles are generated in a manner analogous to the 86% method 
(see Chapter “Radius calculation with the 86% method algorithm” 
on page 137).

	The mathematically approximated circles are shown in the 
coordinates window as dotted circle graphs. The table window 
shows their radii and the relative standard deviation of the points of 
a circle from the measured intensity values.

Show center of gravity 	X Check this box to calculate the center of gravity of the circles.

	Crosses indicating the two-dimensional centers of gravity appear 
(only in polar view). The table window shows their coordinates and 
their relative deviation with respect to the beam’s center of gravity 
(calculated according to the first moment method; see Chapter 
“Calculation of beam position” on page 136).

Show power inclusion 	X Check this box to show results in the graph and table windows.

Free parameters 1.	 Enter any value in the input field in order to determine the power 
inclusion in percent.

2.	 If required, check the box to display the results in the graph and 
table windows.

Intensity in kW/cm² 1.	 Enter any value in the input field in order to determine the minimum 
intensity.

2.	 If required, check the box to display the results in the graph and 
table windows.

Tab. 6.38:	 Options in the Overall settings window for the Beam symmetry analysis tool
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Graph settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Center 	X Click on this button to center the graphic.
	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Remove selection 	X Click on this button to remove all the distances marked in the 
coordinates window.

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the graph data in numerical form as a 
file with the extension .csv.

Export graphic (.png) 	X Click on this button to save the graph in its current state as a 
graphics file with the extension .png.

Copy graphic 	X Click on this button to copy the graph in its current state to the 
clipboard.

Display Drop-down menu

Maximum number of points This option refers to calculation points in the displayed graphs. 

The maximum number of points displayed can be limited in the  
following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

 
Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position.

Fit algorithms Drop-down menu

Fit algorithms can be applied to the entire x-range of a graph as well 
as to individual sub-ranges. The results are displayed by means of fit 
graphs in the coordinates window.

In addition, a table for the numerical display of important fit parameters 
is also displayed. 

Window size can be altered via the side bar. 

Sub-ranges can be marked or removed as described in Tab. 6.37 on 
page 93.

Tab. 6.39:	 Options in the settings window for the Beam symmetry analysis tool
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Option Explanation

Graph window Table window

Legend for columns

Side bar

Columns:
Power inclusion / adjustment /  

center of gravity

x-range

Trend 	X Check the box to apply trend algorithms.

Averaging 	X Check the box to perform averaging.

Caustic fit 	X Check the box to perform a caustic adjustment.

Wavelength The parameter M² (fit algorithmCaustic fit) is calculated as a function  
of wavelength.

	X Enter a value in the input field.

Graph list Drop-down menu

Drop-down list:
Line
Line+points
Points

1.	 Select in the drop-down list a global display form for all graphs.
2.	 If necessary, alter the display form of individual graphs using the 

graph list below the graph.

Line width 	X Enter a value in the input field.

Point size The points are displayed as crosses.

	X Enter a value in the input field.

Graph list Determine for each graph if and how it will be displayed in the 
coordinates window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order  

to toggle the display mode.

Logarithm Drop-down menu for logarithmic display of axes.

A logarithmic display is particularly useful when the range of values 
spans many orders of magnitude. This makes it easier to see 
correlations in the range of small values.

X-axis logarithmic (log10) 	X Check the box to display the x‑axes logarithmically.

Y-axis logarithmic (log10) 	X Check the box to display the y‑axes logarithmically.

Tab. 6.39:	 Options in the settings window for the Beam symmetry analysis tool
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6.3.6	 Caustic analysis

This tool shows the results of a caustic measurement in graphical and tabular form.

In this tool window, both the project tree element Caustic and the element itself can be opened 
Plane by clicking and dragging. The higher-level caustic is then shown, and the selected plane 
marked in the filmstrip.

Structure of the tool window

                                

Graph window

Drop-down list  
to select algorithm

Start/Stop  
button

Selected plane

Side bar  
to adjust size

Filmstrip

Gear icon opens:

Settings window

Radii and  
caustic fits in 

coordinates window

Legend

Table window  
with tabs

Results
Review
Details

Reference

Fig. 6.16:	 Structure of the Caustic analysis tool 
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Elements Description

Graph window Control options
Information on the control options in this window can be found in Tab. 6.41 on 
page 99.

Top left: Start/Stop button 
Clicking on the green Start button causes the filmstrip to automatically spool through 
the individual planes, starting with the lowest plane of a caustic.
To halt this process, click on the red Stop button.

Left-hand side: Filmstrip of the individual planes 
The filmstrip shows a false-color view of the power density distribution of individual 
planes. The active plane is marked by a frame. The project tree name of the active 
plane is displayed above the filmstrip. 

Right-hand side: Coordinates window
The coordinates window shows the caustic longitudinal section and a legend 
(depending on the settings selected). The calculated radius of the individual planes is 
plotted on the x-axis, the z-position on the y-axis.

The following elements can be displayed in the coordinates window:
•	 Whenever the mouse cursor is hovered over the top-right corner of the 

coordinates window, a gear icon appears. This is used to open the settings 
window. 

•	 The dotted orange line shows the z-position of the active plane. 
•	 Blue elements mark the measured radii and caustic fits. The radii and graphs to 

be displayed are selected in the separate settings window. In addition, the mode 
of display can be set here.

Top-right: Drop-down list to select algorithm
Further information can be found in Chapter “Drop-down list to select algorithm” on 
page 101.

Settings window The settings window features options for graphically adjusting the coordinates 
window and for exporting the contents of the window. Further information can be 
found in Tab. 6.42 on page 100.

Table window The tables for this area are included in the following tabs:

•	 Results:  
Contains the parameters calculated for a caustic.

•	 Review:  
Contains the parameters that enable a review of a plane measurement. The 
review is visually supported by means of colored markers. Further information 
can be found in Chapter “The Review tab in the Caustic Analysis tool” on 
page 103.

•	 Details:  
Contains additional information on a measurement. If comments on a caustic 
measurement have been created in the project tree, these are also displayed in 
this tab.

•	 Reference:  
Further information can be found in Chapter “Reference tab” on page 104.

Tab. 6.40:	 Elements of the Caustic analysis tool
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Control options in the graph window

Range Explanation

Filmstrip To activate a plane:
	X Click on the required plane.

	The dotted orange line in the coordinates window to the right of the 
filmstrip shows the z-position of the plane. 

	If, within the same toolbench, plane data is displayed in other tools, 
the display is also updated there. This presupposes that these tools 
are not locked.

To toggle between planes:
	X Use the up/down arrow keys. 

To open a plane in the Plane analysis tool:
	X Double-click on this plane.

	If the tool is not already open Plane analysis in the same toolbench, 
this will automatically occur. 

Coordinates window Opening the settings window:
1.	 Hover the mouse cursor over the coordinates window. 
2.	 Click on the gear icon in the top-right corner.

To activate a plane:
	X With the mouse, drag the dotted orange line to the position of the 

desired plane.
	The action of moving the dotted line automatically displays the 
corresponding plane in the filmstrip.

Tab. 6.41:	 Control options in the graph window of the Caustic analysis tool
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Settings window

The table below lists all the options in order of appearance. Some options/drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Export Drop-down menu

Table export (.csv) 	X Click on this button to save in numerical form the radii and caustic 
fits of the coordinates window as a file with the extension .csv.  
It is irrelevant which radii and caustic fits are currently displayed in 
the coordinates window. The values of all radii and caustic fits are 
always exported. 

Export graphic (.png) 	X Click on this button to save the coordinates window in its current 
state as a graphics file with the extension .png. If legends are 
hidden, they are not included in the exported graphic.

Display Drop-down menu

Maximum number of points The maximum number of measurement points displayed can be limited 
in the following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

 
Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position. 

Graph list Drop-down menu for display options for measured radii and caustic fits.

Depending on the algorithm selected, the radii and caustic fits are 
displayed either simply or separately according to main axes:
•	 Rotated moments: Beam main axes a/b
•	 Device moments: Device main axes x/y

Line width 	X Enter a value in the input field.

Point size The points for the radii are displayed as squares, the points for the 
caustic fits as circles.

	X Enter a value in the input field.

Caustic fit Determine if and how caustic fits are to be displayed in the coordinates 
window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

select the display mode.

Plane radius Determine if and how these radii are to be displayed in the coordinates 
window:

	X Check this box to display the radii.
	X Click repeatedly on the icon to the right of the checkbox in order to 

toggle the display mode.

Tab. 6.42:	 Options in the settings window for the Caustic analysis tool
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Drop-down list to select algorithm

In the top-right corner of the tool window there is a drop-down list to select the algorithm used to calculate 
the radius. Both the elements in the graph window and the values in the table window are calculated/
recalculated according to the selected algorithm (see Fig. 6.17 on page 102). Further information on 
calculation methods can be found in Chapter 7.5 on page 137.

PRIMES recommends always starting a caustic analysis with a well-considered choice of algorithm. 
Results can differ significantly depending on the choice of algorithm. In turn, the review of validity 
in the Review tab may also vary (see chapter “The Review tab in the Caustic Analysis tool” on 
page 103).

	X Select an algorithm from the drop-down list:
•	 Device moments:  

Radii are calculated according to the second moment method in the device coordinates (x/y).  
This produces radii in x-/y-orientation. 

•	 Invariant moments:  
Radii are calculated according to the second moment method in the device coordinates (x/y).  
This produces the average of the radii in x-/y-orientation.

•	 Rotated moments:  
Following conversion of the device coordinates (x/y) into beam coordinates (a/b), the radius calculation  
is performed according to the second moment method. This produces radii in a-/b-orientation.

•	 86%:  
Radii are calculated according to the 86% method. This produces a radius.
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Selection of an algorithm

Depending on  
the algorithm selected:

Calculated values in  
the tabs: Display options in  

the settings:

Depending on the settings selected:  
graphical display of a caustic

Results Review Reference

Fig. 6.17:	 Starting point of a caustic analysis: Selection of an algorithm
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The Review tab in the Caustic Analysis tool

To ease measurement routines, PRIMES has translated the requirements for an ISO 11146 measurement 
with LDS into individual, easily verifiable parameters. LDS rates the quality of each parameter with a traffic 
light system. A red light means that a requirement according to ISO 11146 (or a related requirement 
pertaining to a measurement parameter) has been violated. As the number and severity of parameter 
violations increases, so too does the uncertainty of each measurement. If all parameters are green, the 
measurement can be regarded as reliable and highly accurate.

The values displayed are marked red or green in the table:
•	 Red: one of the limit values factory configured as a criterion of validity has been violated
•	 Green: the limit values specified as a criterion of validity have been met

If one or more of the values displayed is marked red, then a red cross appears next to the title of the tab 
(if not, a green check mark appears). A red cross indicates that the measurement should be repeated with 
optimized parameters. (see Fig. 6.18 on page 103).

The review of a caustic measurement in the Review tab can produce different results depending on which 
algorithm is selected for radius calculation (see Fig. 6.18 on page 103).

Please note: In the project tree, the element Caustic is always reviewed on the basis of the default standard 
algorithm. Conversely, in the Review tab of the Caustic analysis tool, this review is always based on 
the algorithm that is currently selected for that tool. For this reason, the review in the Review tab may be 
different to the review in the project tree.
The default standard algorithm can be selected in the menu bar Extras > Options > Software > Standard 
algorithm.

Same caustic measurement,  
but with a different algorithm

At least one 
figure red 

Invalid 
measurement

All green

Valid 
measurement

Fig. 6.18:	 Review of a caustic measurement in the Review tab 
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Parameter Explanation

Averaged fit deviation in % Averaged deviation of fit from data in percent.
Upper warning value: 3.0
Upper limit value: 3.5

Fill factor Ratio of beam diameter to width of measurement window. If the fill factor 
is too small, this impacts the resolution of the recorded beam. If the 
fill factor is too large, there is a risk that the beam will be clipped. The 
automatic selection of an ROI by the LDS chooses optimal fill factors 
(target value: 0.33).

Min. fill factor Plane with the smallest fill factor.
Lower warning value: 0.30 

Max. fill factor Plane with the largest fill factor.
Upper warning value: 0.60
Upper limit value: 0.75

Δ zMeas/zR Ratio of the recorded z‑length to the calculated Rayleigh length.  
The optimal value is 6.0.
Lower limit value: 4

# planes per zR Number of measured planes per calculated Rayleigh length.  
The optimal value is 3.5.
Lower limit value: 3

Min. SNR: Value of the lowest signal-to-noise ratio.
Lower warning value: 35
Lower limit value: 20

Max. signal level in % Value of the largest modulation related to sensor dynamics.  
The optimal value is 75.
Upper limit value: 95

Max. proportion of overdriven  
pixels in %

Value of the permissible number of overdriven pixels  
(modulation > 95%).
Upper limit value: 0.2

Tab. 6.43:	 Review parameters of the Caustic analysis tool

A systematic introduction to this topic and a detailed description of the tools used to review parameters is 
provided in Chapter 8.2 “Review of parameters with colored markers” on page 140.

 Reference tab

This tab only appears if one of the caustic measurements loaded in the project tree is marked as a reference 
measurement. 

The Reference tab lists the same parameters as the Results tab. In this case, however, it is the deviation of 
the measurement results from those of the reference measurement that is calculated. In order to determine 
a reference range, a lower and upper threshold value are configured for each parameter. When a parameter 
deviates beyond this reference range, this is indicated by a red marking.
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Proceed as follows in order to configure a caustic measurement as a reference measurement:

1.	 Right-click on the relevant caustic 
element in the project tree. This opens 
the corresponding context menu.

2.	 Click on the menu item Is reference 
measurement.

 Green lines appear above and below 
the element. If applicable, these will 
be removed from the element that 
was previously marked as a reference 
measurement.

Proceed as follows in order to configure reference ranges:

1.	 Right-click on the reference 
measurement in the project tree.  
This opens the corresponding 
context menu.

2.	 Click on the menu item 
Edit measurement details.

	A separate toolbench of the same 
name opens.

3.	 Use one of the following options to 
configure a reference range:

	X Click the checkbox Absolute values, 
if absolute values are to be calculated 
instead of percentage ones. 
Enter the minimum/maximum 
threshold values in the left/right 
column. Confirm each value by 
pressing the Enter key.

	X Click on the button Load reference 
in order to load a threshold value from 
a preconfiguration file with an .xml 
extension.

The default NaN (“Not a Number”) 
signifies that no value has been 
defined.
The area Raw beam parameter 
only appears when the 
reference measurement has 
been conducted with the 
LaserQualityMonitor LQM+ 
measuring device.

	Following a configuration of reference 
ranges, other caustic elements in 
the project tree may also be marked 
red. This indicates that they deviate 
beyond the reference range.
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4.	 Click on the button Save reference 
in order to save as a preconfiguration 
file with an .xml extension.

5.	 Open the tool Caustic analysis in 
order to analyze the comparative 
results. To view deviations in a tool 
that is already open, drag the caustic 
measurement back into that tool.

If reference ranges have been 
entered in the Raw beam 
parameter area, then the 
comparative results are displayed 
in the Raw beam analysis tool.

6.	 Click on the Reference tab:
•	 In the reference measurement tab, 

all the values are set to 0 (near right). 
Colored markers indicate that a 
reference range has been configured 
for the parameter. 

•	 Values that deviate beyond a 
reference range are marked red (far 
right). If not, they are marked green

•	 If no threshold value has been defined 
(NaN in each field), there are no 
colored markers.

Reference measurement Other measurement
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6.3.7	 3D caustic display

This tool generates a three-dimensional caustic display. The power density distributions of the planes are 
shown as false-color views.

In this tool window, both the project tree element Caustic and the element itself can be opened 
Plane by clicking and dragging. The higher-level caustic is then shown.

Structure of the tool window

Settings window

Gear icon opens:

x-axis/y-axis

z-axis

Axes:

Planes in  
false-color view

Graph window

Fig. 6.19:	 Structure of the 3D caustic display tool 

Elements Description

Graph window This three-dimensional view can be rotated through all spatial axes and is scalable to 
any size.
When the mouse cursor is hovered over the graph window, the following controls 
options are available:
Opening the settings window:

	X Click on the gear icon in the top-right corner.
Zooming to the center of the graph window:

	X Turn the mouse wheel.
Rotating the view about its axes:

	X Press and hold the left mouse button and drag the graphic.
Moving the graphic:

	X Press and hold the right mouse button and drag the graphic.
Centering the graphic:

	X Double-click.

Settings window The settings window contains options for adjusting the graph window and a  
drop-down list to select the algorithm used to calculate the radius. Further 
information can be found in Tab. 6.45 on page 108.

Tab. 6.44:	 Elements of the 3D caustic display tool
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Settings window

The table below lists all the options in order of appearance. 

Option Explanation

False-color palette For advanced analysis, different color palettes can be selected. 

Color palettes based on root functions provide a nuanced display of 
signal components with a very low intensity. This can be particularly 
useful when analyzing small variations near the zero level (e.g., for 
analyzing diffraction patterns).

	X Select color palette from the drop-down list:
•	 Linear:  

Linear color palette.
•	 2nd root:  

Color palette based on the second root (colors assigned according 
to the second root of the power density values of each pixel).

•	 4th root:  
Color palette based on the fourth root (colors assigned according to 
the fourth root of the power density values of each pixel).

•	 Grayscale:  
Color palette in grayscale. 

Transparency The following options are available to determine the transparency of 
false-color views:

	X Enter a value between 0 and 1 in the input field.
	X Use the slider beneath the input field.

Amplitude in cts 
Intensity in kW/cm²

Depending on whether the option Intensity scaling has been activated, 
a value for amplitude (ADC value) or for intensity in kW/cm² can be 
entered here. It only makes sense to enter a value for intensity, however, 
when a value for power has been entered or calculated for the purposes 
of a measurement.

The ADC value (ADC = analog-digital count) corresponds to the raw 
data from the analog-to-digital converter. This is equal to intensity plus 
the zero level. In some instances, cts (counts) is given as the unit for the 
ADC value.

The value entered serves as the threshold value for a section.  
ADC values / intensity values beneath the threshold are hidden in the 
false‑color view. 

To set a threshold, select one of the following options:
	X Enter a value in the input field. To confirm, press the Enter key.
	X Use the color-palette slider beneath the input field.
	X Click on the color-palette slider. Move it by pressing the left/right 

arrow keys.

Center measurement 	X Click on this button to center the graphic.
	This automatically rotates the graphic and scales it to size.

Intensity scale 	X Check this box to display amplitude (ADC value in counts) rather 
than intensity.

It is only possible to display the intensity when a power value has been 
entered or calculated for the purposes of a measurement.

Tab. 6.45:	 Options in the settings window for the 3D caustic display tool
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Option Explanation

Algorithm The radii are calculated/recalculated according to the algorithm selected. 
Further information on calculation methods can be found in Chapter 7.5 
on page 137.

	X Select an algorithm from the drop-down list:
•	 Device moments:  

Radii are calculated according to the second moment method in the 
device coordinates (x/y). This produces radii in x-/y-orientation. 

•	 Invariant moments:  
Radii are calculated according to the second moment method in the 
device coordinates (x/y). This produces the average of the radii in 
x-/y-orientation.

•	 Rotated moments:  
Following conversion of the device coordinates (x/y) into beam 
coordinates (a/b), the radius calculation is performed according to 
the second moment method. This produces radii in a-/b-orientation.

•	 86%:  
Radii are calculated according to the 86% method. This produces a 
radius.

Show dimensions 	X Check this box to show the calculated diameters.

Show angle of caustic 	X Check this box to show a line that represents the calculated 
direction of beam propagation.

Show angle 	X Check this box to show the lines representing the beam/device 
main axes.

Coordinate system 	X Check this box to display axes.

Tab. 6.45:	 Options in the settings window for the 3D caustic display tool
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6.3.8	 Process volume

This tool is used to calculate the process volume of a laser beam at any given minimum intensity. To determine 
the process volume and other related parameters, planes that exceed the minimum intensity are used. The 
results are shown in graphical and tabular form.

In this tool window, both the project tree element Caustic and the element itself can be opened 
Plane by clicking and dragging. This will then calculate the process volume for the higher-level 
caustic.

Structure of the tool window

Legend

Input:
Minimum 
intensity

x: z-position

Axes:

y: Radius

Table window 

Gear icon opens:

Settings window

Settings

Coordinates window: 
Process volume

Coordinates window: 
Symmetry analysis 

Middle of  
process volume

3D view:  
Process volume

Fig. 6.20:	 Structure of the Process volume tool 
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Elements Description

Coordinates window: 
Process volume

Control options
Information on the control options in this window can be found in Tab. 6.47 on 
page 112.

Coordinates window
The coordinates window shows a graph of process volume at a given intensity. The 
z-position is plotted on the x-axis, the radius on the y-axis. A legend can be displayed 
to show the given intensity for the graph.

Settings window The settings window contains options for adjusting the coordinates window showing 
process volume and for exporting data. Further information can be found in Tab. 6.48 
on page 113.

Opening the settings window:
1.	 Hover the mouse cursor over the tool window until the gear icon appears in the 

top-right corner. 
2.	 Click on the gear icon to open the settings window.

Coordinates window: 
Symmetry analysis

Control options
Information on the control options in this window can be found in Tab. 6.47 on 
page 112.

The coordinates window displays the results of a beam symmetry analysis. This 
shows the measurement plane that lies approximately in the middle of the process 
volume.

The following elements are plotted:
•	 Solid line showing the outline of the measured intensity values.
•	 Dotted line showing a circle mathematically approximated to the measured 

values. A circle is generated with a minimum deviation from the contours of the 
measured values.

Table window At the top of the table window, a value for the minimum intensity can be entered.  
The values of the process volume calculated on this basis are displayed in the  
table below.

To enter a minimum intensity value, select one of the following options:
	X Enter a value in the input field. To confirm, press the Enter key.
	X Use the slider beneath the input field.
	X Click on the slider. Move it by pressing the left/right arrow keys.

3D view:  
Process volume

This three-dimensional view of process volume can be rotated through all spatial axes 
and is scalable to any size.

When the mouse cursor is hovered over the graphic, the following controls options 
are available:

Zooming to the center of the graph window:
	X Turn the mouse wheel.

Rotating the view about its axes:
	X Press and hold the left mouse button and drag the graphic.

Moving the graphic:
	X Press and hold the right mouse button and drag the graphic.

Centering the graphic:
	X Double-click.

Tab. 6.46:	 Elements of the Process volume tool
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Control options in coordinates windows 

Instead of the right mouse button, the left mouse button can also be used while holding down the Alt key.

Action Procedure

Zooming to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Use one of the following options:

	X Press and hold the right mouse button and drag in the required 
direction.

	X Use the arrow keys to incrementally move in the required direction.

Center graphs in the coordinates window 	X Double-click on the coordinates window.
	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Display coordinate values at any position 
in a graph

	X Click on the relevant area of the graph. 
	The corresponding information is displayed.

Mark an area along the x-axis Any number of areas can be marked along the x-axis. This serves to 
measure distances.

To mark distances, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the x-axis. 
4.	 If required, repeat to mark further areas along the x-axis.

Removing a marked area 1.	 Press and hold the Shift key. 
2.	 Click on the area to be removed.

Removing all marked areas
(only in the coordinates window for 
process volume)

	X Press the Remove selection button in the settings window.

Tab. 6.47:	 Control options in coordinates windows
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Settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Table export (.csv) 	X Click on this button to save the measurement data for all caustic 
planes in numerical form as a file with the extension .csv.

Graph Drop-down menu 

These options apply only to the coordinates window for  
process volume.

Center 	X Click on this button to center the graphic.
	The axes are moved and scaled so that the graph completely fills 
the coordinates window in all directions. 

Remove selection 	X Click on this button to remove all the distances marked in the 
coordinates window. 

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the data displayed in the coordinates 
window in numerical form as a file with the extension .csv. 

Export graphic (.png) 	X Click on this button to save the coordinates window in its current 
state as a graphics file with the extension .png.

Copy graphic 	X Click on this button to copy the coordinates window in its current 
state to the clipboard.

Display Drop-down menu

Maximum number of points The maximum number of measurement points displayed can be limited 
in the following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

 
Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position. 

Graph list Drop-down menu

Drop-down list:
Line
Line+points
Points

	X In the drop-down list, select a display mode for the graph.

Line width 	X Enter a value in the input field.

Point size The points are displayed as circles.

	X Enter a value in the input field.

Graph list Determine if and how this graph is to be displayed in the coordinates 
window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

toggle the display mode.

Tab. 6.48:	 Options in the settings window for the Process volume tool
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6.3.9	 Focus shift

This tool enables an evaluation of a series of caustics in respect of a possible focus shift  
(see Chapter 8.4 “A focus shift and the temporal stability of measurement results” on page 144).

To achieve a meaningful assessment of focus shift, it is recommended to perform caustic 
measurements at substantially different laser powers.

Structure of the tool window

Overall settings 
window

                                

Numerical window

Graph window

Graphics settings 
window

Displayable 
legend

Gear icon opens:

Dotted line:
Trend graph

Fig. 6.21:	 Structure of the Focus shift tool 
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Elements Description

Graph window Information on the control options in this window can be found in Tab. 6.50 on 
page 116.

The coordinates window shows graphs for ΔZ/zR as a function of laser power and  
for the overall trend (dotted line).

Depending on which algorithm is selected to calculate the radius, graphs are 
displayed either simply or separately according to main axes:
•	 Device moments: Device main axes x/y
•	 Invariant moments: simple
•	 Rotated moments: Beam main axes a/b
•	 86%: simple

A legend can be displayed to assign the displayed graphs.

Overall settings 
window

The Overall settings window contains two drop-down lists for basic options. 

Drop-down list Algorithm
The radii of the caustic planes are calculated/recalculated according to the algorithm 
selected. Further information on calculation methods can be found in Chapter 7.5 on 
page 137.

	X Select an algorithm from the drop-down list:
•	 Device moments:  

Radii are calculated according to the second moment method in the device 
coordinates (x/y). This produces radii in x-/y-orientation. 

•	 Invariant moments:  
Radii are calculated according to the second moment method in the device 
coordinates (x/y). This produces the average of the radii in x-/y-orientation.

•	 Rotated moments:  
Following conversion of the device coordinates (x/y) into beam coordinates (a/b), 
the radius calculation is performed according to the second moment method. 
This produces radii in a-/b-orientation.

•	 86%:  
Radii are calculated according to the 86% method. This produces a radius.

Drop-down list Review
	X Select an algorithm from the drop-down list:

•	 Relative focus shift: The relative focus shift is calculated in the Rayleigh length 
units zR per kW.

•	 Single mode: The relative focus shift is calculated in the Rayleigh length units zR 
per kW in single mode; i.e., adjusted for M2. This allows for the fact that the value 
for M2 may change during a focus shift. 

Graphics settings 
window

The Graph settings window features options for graphically adjusting the coordinates 
window and for exporting the contents of the window. Further information can be 
found in Tab. 6.51 on page 117.

Numerical window This shows the relative focus shift in the Rayleigh length units zR per kW (depending 
on settings).
Depending on which algorithm is selected to calculate the radius, values are 
displayed either simply or separately according to main axes:
•	 Device moments: Device main axes x/y
•	 Invariant moments: simple
•	 Rotated moments: Beam main axes a/b
•	 86%: simple

Tab. 6.49:	 Elements of the Focus shift tool
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Control options in the graph window

Instead of the right mouse button, the left mouse button can also be used while holding down the Alt key.

Action Procedure

Zooming to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Use one of the following options:

	X Press and hold the right mouse button and drag in the required 
direction.

	X Use the arrow keys to incrementally move in the required direction.

Center all graphs in the coordinates 
window

	X Double-click on the coordinates window, but not in the immediate 
vicinity of a graph.

	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Display coordinate values at any position 
in a graph

	X Click on the relevant area of the graph.
	The corresponding information is displayed.

Opening the graph settings window 1.	 Hover the mouse cursor over the coordinates window until the gear 
icon appears in the top-right corner. 

2.	 Click on the gear icon to open the settings window.

Mark an area along the x-axis Any number of areas can be marked along the x-axis. This serves to 
measure distances.

To mark distances, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the x-axis.
4.	 If required, repeat to mark further areas along the x-axis.

Removing a marked area 1.	 Press and hold the Shift key.
2.	 Click on the area to be removed.

Tab. 6.50:	 Control options in the graph window
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Graph settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the graph data in numerical form as a 
file with the extension .csv. 

Export graphic (.png) 	X Click on this button to save the graph in its current state as a 
graphics file with the extension .png.

Copy graphic 	X Click on this button to copy the graph in its current state to the 
clipboard.

Display Drop-down menu

Maximum number of points The maximum number of measurement points displayed can be limited 
in the following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

 
Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position. 

Graph list Drop-down menu

Depending on which algorithm is selected to calculate the radius, graphs 
are displayed either simply or separately according to main axes:
•	 Device moments: Device main axes x/y
•	 Invariant moments: simple
•	 Rotated moments: Beam main axes a/b
•	 86%: simple

Line width 	X Enter a value in the input field.

Point size The points are displayed as circles and squares.

	X Enter a value in the input field.

Graph list Determine for each graph if and how it will be displayed in the 
coordinates window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

change the display mode.

Tab. 6.51:	 Options in the settings window for the Focus shift tool
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6.3.10	 Raw beam analysis

This tool shows the results of a raw beam back calculation in graphical and tabular form. Calculation  
of raw beam parameters from a measured caustic is only possible for measurements with the 
LaserQualityMonitor LQM+ measuring device. This uses the formula described in ISO 11146.

The project tree element Caustic can also be opened in this tool window. However, measurement 
results are only displayed if the measurement has been performed with a suitable measuring 
device.
In addition, the element Plane can be opened by clicking and dragging. The back calculation is 
then based on the higher-level caustic.

Structure of the tool window

                                

Graph window

Gear icon opens:

Settings window

Table window  
with tabs

Results
Review
Details

Reference

Side bar  
to adjust size

Orange: 
Beam exit (laser) / beam 

entrance (measuring device)

Blue: 
Radii and graphs

Drop-down list  
to select algorithm

x: z-position

y: Radius

Axes:

Legend

Fig. 6.22:	 Structure of the Raw beam analysis tool 
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Elements Description

Graph window Control options
Information on the control options in this window can be found in Tab. 6.53 on 
page 120.

Coordinates window
The coordinates window shows the caustic longitudinal section of the raw beam and 
a legend (depending on the graphic settings selected). The z-position is plotted on 
the x-axis, the back-calculated radius on the y-axis.

The following elements can be displayed in the coordinates window:
•	 Whenever the mouse cursor is hovered over the top-right corner of the 

coordinates window, a gear icon appears. This is used to open the settings 
window.

•	 The orange lines show the z-position of the beam exit at the laser/collimator and 
of the beam entrance at the optics of the measuring device. The position of the 
beam exit is only displayed if a distance between the device and laser has been 
entered in the measurement details.

•	 Blue elements show the radius/radii, as a function of the z‑position, and the 
beam waist. The graphs to be displayed are selected in the separate settings 
window. In addition, the mode of display can be set here.

Drop-down list to select algorithm
In the top-right corner of the tool window there is a drop-down list to select the 
algorithm used to calculate the radii of the actual caustic. The results of the raw beam 
back calculation can differ substantially depending on the algorithm selected for the 
caustic calculation. Further information can be found in Chapter “Drop-down list to 
select algorithm” on page 101.

Settings window The settings window features options for graphically adjusting the coordinates 
window and for exporting the contents of the window. Further information can be 
found in Tab. 6.54 on page 121.

Table window The tables for this area are included in the following tabs:

•	 Results:  
Contains the back-calculated raw beam parameters. The radius at the beam exit 
of the laser/collimator is only calculated if a distance between the device and 
laser has been entered in the measurement details. The numerical aperture of the 
fiber is only calculated if a focal length for the collimator has been entered in the 
measurement details. (Measurement details are called up via the context menu in 
the project tree; see Chapter 5.4.6 on page 21).

•	 Review:  
Contains the relevant parameters of the actual caustic measurement; i.e., as in 
the similarly named tab of the tool Caustic analysis (see Chapter “The Review 
tab in the Caustic Analysis tool” on page 103).

•	 Details:  
Contains additional information on a measurement. If comments on a caustic 
measurement have been created in the project tree, these are also displayed in 
this tab.

•	 Reference:  
If a caustic measurement with raw beam back calculation is activated as a 
reference measurement, the deviation between the back-calculated raw beam 
parameters and the reference values are displayed here. Further information can 
be found in Chapter “Reference tab” on page 104.

Tab. 6.52:	 Elements of the Raw beam analysis tool



LaserDiagnosticsSoftware LDS

120 Revision 03 EN – 02/2023 

Control options in the graph window

Instead of the right mouse button, the left mouse button can also be used while holding down the Alt key.

Action Procedure

Zooming to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Use one of the following options:

	X Press and hold the right mouse button and drag in the required 
direction.

	X Use the arrow keys to incrementally move in the required direction.

Center graphs in the coordinates window 	X Double-click on the coordinates window.
	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Display coordinate values at any position 
in a graph

	X Click on the relevant area of the graph. 
	The corresponding information is displayed.

Opening the settings window 1.	 Hover the mouse cursor over the coordinates window until the gear 
icon appears in the top-right corner. 

2.	 Click on the gear icon to open the settings window.

Mark an area along the x-axis Any number of areas can be marked along the x-axis. This serves to 
measure distances.

To mark distances, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the x-axis. 
4.	 If required, repeat to mark further areas along the x-axis.

Removing a marked area 1.	 Press and hold the Shift key. 
2.	 Click on the area to be removed.

Tab. 6.53:	 Control options in the graph window
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Settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Zoom view This view shows the area of the beam waist and the side of the raw 
beam adjacent to the measuring device.

	X Check the box to activate this option.

Show beam waist 	X Check the box to show the radii at the beam waist.

Show LQM 	X Check this box to show the z‑position of the beam entrance at the 
optics of the measuring device.

Show laser source 	X Check this box to show the z‑position of the beam exit at the  
laser/collimator.

Graph Drop-down menu

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the graph data in numerical form as a 
file with the extension .csv. 

Export graphic (.png) 	X Click on this button to save the graph in its current state as a 
graphics file with the extension .png.

Copy graphic 	X Click on this button to copy the graph in its current state to the 
clipboard.

Display Drop-down menu

Maximum number of points In this case, points do not refer to measurement points – as here the 
radii of the raw beam are back calculated, not measured. Instead, it 
refers to the mode of display for the graphs.

The maximum number of points displayed can be limited in the  
following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is  
used to change the size of the section shown.

 
Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position. 

Graph list Drop-down menu

Line width 	X Enter a value in the input field.

Point size In this case, points do not refer to measurement points – as here the 
radii of the raw beam are back calculated, not measured. Instead, it 
refers to the mode of display for the graphs. The points are displayed as 
circles and squares.

	X Enter a value in the input field.

Graph list Determine for each graph if and how it will be displayed in the 
coordinates window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

change the display mode.

Tab. 6.54:	 Options in the settings window for the Raw beam analysis tool
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6.3.11	 Beam pointing stability

With camera-based measuring devices, beam pointing stability can be monitored. For this purpose, the 
device performs plane measurements alternately at two z-positions of a beam. The points measured in 
this way show the position of the beam’s center of gravity on the focal plane as well as the beam’s angle 
of incidence to the z-axis. The measurement points are shown in the two coordinates windows of the tool 
Beam pointing stability. 

Only logged measurements and measurements saved as caustics can be displayed.
In this tool window, both the project tree element Caustic and the element itself can be opened Plane by 
clicking and dragging. The higher-level caustic is then analyzed.

Structure of the tool window

Gear icon opens:

Settings window

Settings

Circle:
Variance

Legend

Numerical data: 
Circle center and standard deviation

Settings

Coordinates window:
Position

Coordinates window:
Angle 

Fig. 6.23:	 Structure of the Beam pointing stability tool 
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Elements Description

Coordinates window: 
Position

Control options
Information on the control options in this window can be found in Tab. 6.56 on 
page 124.

Coordinates window
The coordinates window shows the position of the beam’s center of gravity on the 
focal plane. The measurement points are displayed as crosses. 

The lines joining the points show the temporal sequence of the measurements. The 
final position of the laser beam is represented by a large cross, former positions by a 
small cross.

The dotted circle shows the variance (spread of the probability density around its 
center of gravity) of the measurement points. Beneath the window, the following 
numerical information is shown: 
•	 x/y coordinates: Center of circle
•	 Sigma value: statistical deviation

A legend can be displayed.

Coordinates window: 
Angle

The coordinates window shows the angle between beam and z-axis.
The measurement points are displayed as crosses.

All other aspects are identical to those of the coordinates window Position.

Settings window The settings window contains options for adjusting the coordinates window and for 
exporting data. Further information can be found in Tab. 6.57 on page 125.

Opening the settings window:
1.	 Hover the mouse cursor over the tool window until the gear icon appears in the 

top-right corner. 
2.	 Click on the gear icon to open the settings window.

Tab. 6.55:	 Elements of the Beam pointing stability tool
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Control options in coordinates windows 

Instead of the right mouse button, the left mouse button can also be used while holding down the Alt key.

Action Procedure

Zooming to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Use one of the following options:

	X Press and hold the right mouse button and drag in the required 
direction.

	X Use the arrow keys to incrementally move in the required direction.

Center graphs in the coordinates window 	X Double-click on the coordinates window.
	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Display coordinate values at any position 
in a graph

	X Click on the relevant area of the graph. 
	The corresponding information is displayed.

Mark an area along the x-axis Any number of areas can be marked along the x-axis. This serves to 
measure distances.

To mark distances, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the x-axis. 
4.	 If required, repeat to mark further areas along the x-axis.

Removing a marked area 1.	 Press and hold the Shift key. 
2.	 Click on the area to be removed.

Tab. 6.56:	 Control options in coordinates windows
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Settings window

The table below lists all the options in order of appearance. Some options/drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Graph R/phi Drop-down menu for the coordinates window R/phi

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the data displayed in the coordinates 
window in numerical form as a file with the extension .csv. 

Export graphic (.png) 	X Click on this button to save the coordinates window in its current 
state as a graphics file with the extension .png.

Copy graphic 	X Click on this button to copy the coordinates window in its current 
state to the clipboard.

Display Drop-down menu

Maximum number of points The maximum number of measurement points displayed can be limited 
in the following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

 
Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position. 

Graph list Drop-down menu

Line width 	X Enter a value in the input field.

Point size The points are displayed as circles.

	X Enter a value in the input field.

Graph list Determine if and how this graph is to be displayed in the coordinates 
window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

change the display mode.

Tab. 6.57:	 Options in the settings window for the Beam pointing stability tool
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6.3.12	 Preventive maintenance

Using this tool, limit values can be specified for any parameter. An analysis of previous measurement results 
is used to calculate the future point in time at which limit values are forecast to be reached. This tool is 
suitable for displaying the following project tree elements: Series and Caustic.
This forecast can serve as a basis for future maintenance schedules. If, for example, power is repeatedly 
measured at constant laser power, then falling measurement readings may well indicate increasing 
contamination of the optics. It can then be estimated when, at the latest, the optics should be cleaned in 
order to avoid a limit value violation.

Structure of the tool window

Graph window
Legend

                                

Table window

Gear icon opens:

Settings window

Selectable parameters

Lines:

Yellow: Coordinates G1

Red: Coordinates G2

Dotted: Trend

Input:
y-axis values G1/G2

Fig. 6.24:	 Structure of the Preventive maintenance tool

Elements Description

Graph window Information on the control options in this window can be found in Tab. 6.59 on page 127.

The parameter selected in the settings window is plotted on the y-axis. For the x-axis, 
the inscriptions Index and Timestamp can be selected in the settings window.

The coordinates window shows graphs for the measurement points and for the 
trend. If the graphs are shown as lines (depending on settings), then the graph for the 
measurement points is plotted as a solid line and the graph for the trend as a dotted 
line. If a limit value G1/G2 is entered in the table window, then the coordinates will be 
shown as yellow/red lines. These coordinates are plotted on the trend graph.

Whenever the mouse cursor is hovered over the top-right corner of the graph 
window, a gear icon appears. This is used to open the settings window.

Table window The limit values G1/G2 for the y-axis can be entered in the rows of the table window. 
The corresponding values for the x-axis will then be calculated.

Settings window The settings window contains options for adjusting the graph window and exporting 
data. Further information can be found in Tab. 6.60 on page 128.

Tab. 6.58:	 Elements of the Preventive maintenance tool
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Control options in the graph window
Instead of the right mouse button, the left mouse button can also be used while holding down the Alt key.

Action Procedure

Zooming to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Use one of the following options:

	X Press and hold the right mouse button and drag in the required direction.
	X Use the arrow keys to incrementally move in the required direction.

Center all graphs in the coordinates 
window

	X Double-click on the coordinates window, but not in the immediate 
vicinity of a graph.

	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Display coordinate values at any position 
in a graph

	X Click on the relevant area of the graph. 
	The corresponding information is displayed.

Opening the settings window 1.	 Hover the mouse cursor over the tool window until the gear icon 
appears in the top-right corner. 

2.	 Click on the gear icon to open the settings window.

Calculate a trend for a specific  
x-axis range

The trend algorithm can be selectively applied to a specific x-axis range.
Proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the x-axis.

	Measurement points within a range are marked. The trend for this 
range is then calculated.

Remove selection of an x-axis range 1.	 Press and hold the Shift key. 
2.	 Click on the coordinates window.

Tab. 6.59:	 Control options in the graph window
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Settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

X-axis 	X Select an x-axis inscription from the drop-down list.

Graph Drop-down menu

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the table in its current state as a file with 
the extension .csv.

Export graphic (.png) 	X Click on this button to save the graph in its current state as a 
graphics file with the extension .png.

Copy graphic 	X Click on this button to copy the graph in its current state to the 
clipboard.

Display Drop-down menu

Maximum number of points The maximum number of measurement points displayed can be limited 
in the following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

 
Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position. 

Graph list Drop-down menu

Line width 	X Enter a value in the input field.

Point size The measurement points are displayed as circles, the trend graph as  
a square.

	X Enter a value in the input field.

Graph list Determine for each graph if and how it will be displayed in the 
coordinates window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

change the display mode.

List of parameters Parameters can be selected from the category sublists of the parameter 
list on display. The parameter list on display depends on which project 
tree element is open.
The following options are available:

Open/close a category sublist:
	X  Click on the arrow right / arrow down.

Selecting a parameter:
	X Click on the required parameter.

Tab. 6.60:	 Options in the settings window for the Preventive maintenance tool
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6.4	 The “Power measurement” tool to show power data

This tool shows measurement data as single values in numerical form and the complete measurement series 
as a graph. It is only suitable for displaying the project tree element Power measurement.

This tool is also suited for displaying a running power measurement (see Chapter “Display running 
measurements in a tool” on page 43). 

Structure of the tool window

Settings window

Gear icon opens:Axes separately  
scalable/movable

Dotted lines:
Averaging range

                                

                                

Numerical window
(expanded view) 

Graph window
(expanded view)

Fig. 6.25:	 Structure of the Power measurement tool 

Elements Description

Graph window Information on the control options in this window can be found in Tab. 6.62 on 
page 130.

The coordinates window shows a power graph. The expanded view shows the 
graphs of further parameters. A legend can be displayed that assigns the displayed 
graphs to the corresponding parameters. The y-axes can be moved and scaled 
independently of one another. 

Numerical window This shows the averaged power. The expanded view shows the averaged values for 
certain measurement parameters (e.g., flow rate). The range selected for averaging is 
displayed in the coordinates window.

Permissible variations for specific background parameters are factory configured in 
the measuring devices (e.g., flow rate). If a background parameter moves beyond 
this permissible variation, then the corresponding value is shown against a yellow 
background. This may indicate that the device cannot be used safely or that the 
accuracy of measurement results is reduced.

Settings window The settings window contains options for adjusting the graph window and for 
averaging data. Further information can be found in Tab. 6.63 on page 131.

Tab. 6.61:	 Elements of the Power measurement tool
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Control options in the graph window

Instead of the right mouse button, the left mouse button can also be used while holding down the Alt key.

Action Procedure

Zooming to position of mouse cursor 1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Turn the mouse wheel.

Setting a zoom range 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Press and hold the Crtl key and the left mouse button.
3.	 Draw a square.

Change the scale of an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Turn the mouse wheel.

Shift the display along an axis 1.	 Position the mouse cursor anywhere along the x‑axis/y‑axis.
2.	 Press and hold the right mouse button and drag along the axis.

Shift the display in any direction 1.	 Position the mouse cursor anywhere within the coordinates window.
2.	 Use one of the following options:

	X Press and hold the right mouse button and drag in the required 
direction.

	X Use the arrow keys to incrementally move in the required direction.

Center all graphs in the coordinates 
window

	X Double-click on the coordinates window, but not in the immediate 
vicinity of a graph.

	The axes are moved and scaled so that the graphs completely fill 
the coordinates window in all directions. 

Display coordinate values at any position 
in a graph

	X Click on the relevant area of the graph. 
	The corresponding information is displayed.

Mark an area along the x-axis An area can be marked along the x-axis. This serves to measure 
distances or to define a range for averaging.

To mark an area, proceed as follows:
1.	 Position the mouse cursor anywhere within the coordinates window. 
2.	 Press and hold the Shift key and the left mouse button.
3.	 Mark an area along the x-axis.

	The newly marked, unsaved area is given a background color. The 
previously marked area is no longer shown.

4.	 After use, remove this area or save it as described below.

Removing a marked area with a 
background color

1.	 Press and hold the Shift key. 
2.	 Click on the area marked with a background color.

	The saved area reappears.

Saving a marked area with a background 
color

	X In the settings window, click on the button Save evaluation range.
	The background coloring and the distance value disappear. The 
saved range is indicated by vertical dotted lines.

Tab. 6.62:	 Control options in the graph window
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Settings window

The table below lists all the options in order of appearance. Some options / drop-down menus are only visible 
when the higher-level drop-down menu is open. To open/close a drop-down menu, click on the blue bar.

Option Explanation

Graph Drop-down menu

Export Drop-down menu

Table export (.csv) 	X Click on this button to save the graph data in numerical form as a 
file with the extension .csv. 

Export graphic (.png) 	X Click on this button to save the graph in its current state as a 
graphics file with the extension .png.

Copy graphic 	X Click on this button to copy the graph in its current state to the 
clipboard.

Display Drop-down menu

Maximum number of points The maximum number of measurement points displayed can be limited 
in the following way:

	X Enter a value in the input field.
	X Use the slider beneath the input field.

	In some instances, a slider appears beneath the graph. This is used 
to change the size of the section shown.

 
Enter the value 0 to remove the restriction.

Legend 	X Select in the drop-down list whether a legend is to be displayed – 
and, if so, in which position. 

Graph list Drop-down menu

Line width 	X Enter a value in the input field.

Point size The points are displayed as circles and squares.

	X Enter a value in the input field.

Graph list Determine for each graph if and how it will be displayed in the 
coordinates window:

	X Check the box to display the graph.
	X Click repeatedly on the icon to the right of the checkbox in order to 

toggle the display mode.

Normal/expanded view 	X Click on this button to toggle between different views

Save evaluation range 	X Click on this button to save a range marked with a background 
color in the coordinates window (see Chapter  “Control options in 
the graph window” on page 130).

	The background coloring and the distance value disappear. The 
saved range is shown in the coordinates window by means of 
vertical dotted lines.

Automatic evaluation range 	X Click on this button to automatically create an averaging range.

Tab. 6.63:	 Options in the settings window for the Power measurement tool
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7	 Fundamentals of beam geometry analysis with LDS

7.1	 The beam geometry of rotationally symmetric laser beams

Fig. 7.1 shows schematic cross sections of a rotationally symmetric laser beam with the parameter 
designations used in LDS.

Raw beam diameter dRaw 

Beam direction

Focal length f

Axis z

Divergence angle θ

Focus diameter d0= 2r0

Focus area

z-axis 

d0 = 2r0

zR

θ

Fig. 7.1:	 Schematic beam cross sections along the propagation axis z

Beam focusing

The figure on the left shows beam transformation with focusing optics. The beam direction is from top to 
bottom. Above the focusing lens, the collimated raw beam runs approximately parallel. Below the focusing 
lens, the beam tapers until it reaches its narrowest point, the beam focal point. The beam edges describe – 
in simplified terms – the divergence angle θ (in LDS, this always means the full divergence angle). The focal 
length f determines the distance between the beam focal point and the focusing lens. The focal point has the 
original axial position z = 0 and the diameter d0 = 2r0 (in LDS, the index 0 signifies that a parameter refers to 
the focal point). After reaching its narrowest point, the beam widens again in the same way.

Focus area of beam caustic

The figure on the right shows the cross section of a focused beam in the focus area, the so-called near 
field. The beam caustic shows the typical longitudinal profile of a Gaussian beam. This can be interpreted 
as the rotation of a hyperbola around the axis of propagation. At the focal point, the beam radius is at its 
minimum r0; with increasing distance from the focus, the radius increases non-linearly on both sides. In 
so doing, it asymptotically approaches the straight lines described by the divergence angle θ. At a greater 
distance from the focal point – the far field of the beam – the radius finally becomes approximately linear and 
the full divergence angle is obtained.
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Rayleigh length

In the cross section shown on the right, two important planes are marked perpendicular to the axis of 
propagation z. Here, the cross-sectional area of the laser beam has increased by a factor of 2 and the radius 
by a factor of  2  (≈ 1.41), both with respect to the focal plane. The Rayleigh length zR denotes the distance 
between these planes and the beam focal point. In the case of the ideal TEM00 laser beam, this is the 
quotient of double the focal radius r0 and the divergence angle θ:

(1.1)

Elementary caustic parameters of rotationally symmetric beams

According to ISO 11145 and ISO 11146, the following parameters are required for the characterization of a 
rotationally symmetric beam:

•	 z-position of the beam focal point z0

•	 Focal radius r0

•	 Divergence angle θ

Using these three values, it is possible to determine the beam radius at any position along the direction of 
propagation, provided that the focal radius r0 and the divergence angle θ have been calculated according to 
the second moment method.

(1.2)
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7.2	 Parameters for laser beam focusability

A key determinant of the quality of a laser beam is how well it can be focused. Three related values are used 
to characterize this focusability:

•	 Beam parameter product BPP
•	 Beam quality factor M2

•	 Beam quality k

Beam parameter product BPP

The focal radius r0 and divergence angle θ of a laser beam are inversely proportional: if a smaller focal radius is 
required to achieve a higher power density, then a correspondingly wider divergence angle must be selected.

The product of the focal radius and half the divergence angle – the so-called beam parameter product (BPP) 
– is therefore a constant value:

(1.3)

In the case of the ideal TEM00 laser beam, the beam parameter product is the quotient of the laser wavelength 
λ and the mathematical constant π:

(1.4)

The constancy of the beam parameter product can also be observed for real laser beams. Here, however, in 
contrast to the ideal TEM00 laser beam, both the focal radius r0 and the divergence angle θ are bigger by the 
factor M:

(1.5)

On account of its minimal beam parameter product, the ideal TEM00 laser beam is therefore the benchmark 
for the focusability of real laser beams.

Beam quality factor M2

Given the same divergence angle, real laser beams have a larger focal radius than the ideal TEM00 laser beam. 
The beam quality factor M2 describes this correlation. Given the same divergence angle, the focal radius r0 
increases proportionally to M2. In other words, the larger the value for M2, the more difficult it is to focus a laser 
beam. An ideal TEM00 laser beam has a beam quality factor of 1. All real beams have a larger value.

(1.6)

For beam sources with higher laser power, the beam quality factor is generally smaller than for sources with 
lower laser power.

Beam quality k

The beam quality index k describes beam focusability inversely to M2: the larger the value for k, the easier 
it is to focus a laser beam. An ideal TEM00 laser beam has a beam quality index of 1. All real beams have a 
smaller value.

(1.7)
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7.3	 Simple astigmatic beams

So-called simple astigmatic laser beams are not rotationally symmetric. This results in different beam radii 
depending on orientation.

Coordinate systems

Calculation of beam parameters in line with orientation can be performed using either the laboratory 
coordinate system (x, y, z) or the beam coordinate system (a, b, z).

The term laboratory coordinate system generally refers to an external coordinate system that is 
independent of the beam geometry and therefore provides a fixed frame of reference. As a rule, the device 
coordinate system – defined by the orientation of the measuring device – is used for this purpose. For further 
information, please refer to the device operating manual.

The beam coordinate system is defined by the main axes of the beam ellipse. The axis with the smallest 
angle in relation to the x-axis is designated as the a-axis, and the other is designated as the b-axis. The 
angle between the x-axis and the a-axis is called the azimuth angle φ. Using a coordinate transformation, 
parameters calculated in x and y can also be converted to parameters in a and b, and vice versa.

Beam ellipticity

Beam ellipticity ε is a parameter for determining the circularity of a beam cross-section at a given point along 
the axis of propagation. It is determined as the ratio of the smaller to the larger diameter at this point. In line 
with ISO 11145 and ISO 11146, elliptical distributions ε ≥ 0.87 can be regarded as circular.

Elementary caustic parameters of simple astigmatic beams

Since astigmatic beams have different parameters in the direction of the beam main axes (a and b), they do 
not, as a rule, have a common focal point. The following parameters are used to describe such a beam:

•	 The z-positions of the beam focal points z0a and z0b 
•	 The focal radii r0a and r0b

•	 The divergence angle θ0a and θ0b

•	 The azimuth angle φ

Beam coordinate system (a/b)

Device coordinate system (x/y)

b-axis zLaser

rb

φra

x-axis

a-axis

y-
ax

is
:z0b

z0a

b-axis

z-axis

a-axis

θb

θa

Fig. 7.2:	 Beam parameters of a simple simple astigmatic beam (left) and the relation between device coordinate and 
beam coordinate systems (right)

The above parameters can be used to describe all beams that can be characterized by two mutually 
perpendicular axes. Further beam parameters are calculated – also dependent on orientation – by means 
of the same equations that are used for rotationally symmetric beams. Therefore, there are always two 
parameters; e.g., ka and kb.
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7.4	 Determination of power density distribution for a plane measurement

To calculate the beam radius at any point along the axis of propagation, the two-dimensional power density 
distribution must first be measured. PRIMES systems measure power density distribution with either a  
CCD camera or a scanning device with a rotating pinhole.

Offset

To obtain a correct measurement, it is vital to ensure proper offset, since even small errors can lead to a 
significant change in the calculation volume. If offset is too high, for example, this reduces the intensity at the 
edges of the beam. As a result, the measured values are too low. 

This is particularly noticeable when calculating the radius by means of the second moment method. 
The algorithm for this method is based on the product of power density and distance to the center of 
gravity, squared. Because of the square weighting, the edges of the beam must also be included in 
the measurement to a high degree of accuracy, otherwise this method does not work properly. Careful 
determination of offset is also essential when calculating the radius using the 86% method. By default, offset 
in LDS is determined by means of a “dark measurement” in the device (i.e., without a laser beam).

Fill factors

LDS distinguishes between measurement area, measurement window and ROI (region of interest). The 
measurement area is the complete area measurable by a device. The measurement window is the part of 
the measurement area for which intensity values are recorded during a measurement. The key to obtaining a 
correct measurement is the size and position of the measurement window, thereby ensuring that it contains 
the entire beam. The ROI is the area of the measurement window that is used to calculate the beam radius.

In LDS, the “fill factor” signifies the measurement window fill factor. This is the quotient of the beam 
diameter and the width of the measurement window. In LDS, this must lie between 0.25 and 0.75 in order 
for the measurement to be considered valid. The ROI fill factor is the quotient of the beam diameter and the 
ROI width. To minimize errors in determining offset, an ROI fill factor of 0.5 is ideal according to the quality 
criteria specified by PRIMES.

If measurement window size is set automatically for a measurement, the measurement window fill factor 
is approximately 0.3. This leaves enough of a margin for an ROI fill factor of 0.5 (default value). This default 
value be overwritten with another value in the menu Extras > Options. Alternatively, the use of ROI can be 
deactivated (see Chapter  “Global settings in the Extras > Options menu” on page 28).

Calculation of beam position

The beam position is calculated according to the first moment method; i.e., as the center of gravity of the 
power density distribution I(x,y,z):

(1.8)

The index COG stands for center of gravity.
Based on the beam position, the beam radius can now be calculated using the 86% method or the second 
moment of power density distribution.



LaserDiagnosticsSoftware LDS

137 Revision 03 EN – 02/2023

7.5	 Methods of radius calculation for a plane measurement

The basic version of LDS uses the following methods for radius calculation: second moment method and 
86% method. These methods conform to ISO 11146. For the ideal TEM00 laser beam, both methods deliver 
the same result. For most real laser beams, however, the results of the two methods can differ significantly.

Radius calculation with the 86% method algorithm

The 86% algorithm is used for experimental radius calculation according to the 86% method.

First of all, the volume of the power density distribution is determined. This is proportional to total power. 
Addition of all the power density values and multiplying them by the pixel dimensions gives the volume and 
thus the total power.

Based on this calculation of total power, a circular area is then observed that includes 86% of the total beam 
power. The beam power must lie within the beam radius. Integration starts at the center of gravity. The area 
of integration is then increased until it includes 86% of the total power. For the purposes of integration, the 
number of pixels is counted. This is then used to calculate the 86% area (and thereby the beam diameter). 
This is a very reliable method for circular, fundamental mode-like beams.

Power inclusion

100%

a) b)

86%

Fig. 7.3:	 Graphical representation of the calculation of 86% radius

Fig. 7.3 shows the power density distribution (a) and the pixels that together comprise 86% of the power (b). 
The pixels with lower power are set to zero for clarity.

Radius calculation with second moment method algorithms

The following algorithms are used for radius calculation according to the second moment method:

•	 Device moments:  
Radii are calculated according to the second moment method in the device coordinates (x/y).  
This produces radii in x-/y-orientation. 

•	 Invariant moments:  
Radii are calculated according to the second moment method in the device coordinates (x/y).  
This produces the average of the radii in x-/y-orientation.

•	 Rotated moments:  
Following conversion of the device coordinates (x/y) into beam coordinates (a/b), the radius calculation  
is performed according to the second moment method. This produces radii in a-/b-orientation.
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The second moments are determined in the following way (in this example, for the device coordinates x/y):

(1.9)

Based on the second moments, the beam radii are calculated in x‑/y-orientation:

r r (1.10)

Advanced algorithms for radius calculation as a plug-in option

Not all measuring devices for laser beam diagnostics show the same measurement result when used for 
comparative measurements on the same laser beam. Different measuring devices are validated in different 
ways. In addition, the measuring methods and the evaluation algorithms they use all have an influence on 
beam measurements.

Similarly, not all methods comply with standards but are nonetheless preferred in some spheres (e.g., in the 
scientific field). In concrete cases, it may be helpful to use alternative beam radius definitions (e.g., for the 
design of apertures or for correlation with machining results).

The Caustic algorithms plug-in adds the following methods for radius calculation to those included in the 
basic version of LDS (name of algorithm in brackets):

•	 Knife-edge method according to ISO 11146-3 (Knife)
•	 Slit method according to ISO 11146-3 (Slit)
•	 Gauss-fit method (Gauss)
•	 86% 2 power density loss method (86% 2)
•	 Power inclusion method with freely definable 1st power inclusion (95%)
•	 Power inclusion method with freely definable 2nd power inclusion (99%)

2nd moment Power inclusion Knife-edge method

Slit method Gauss-fit method 86% 2 power density  
loss method

Fig. 7.4:	 Overview of the methods offered by the Caustic algorithms plug-in
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7.6	 Measuring a beam caustic

Number of plane measurements

To determine the elementary caustic parameters of a real laser beam, the radii of the cross-sectional areas 
must be measured at different points along the propagation axis. ISO 11146 stipulates that these radii must 
be determined for at least 10 points within a minimum of 4 Rayleigh lengths – 5 of them within 1 Rayleigh 
length of the focus and 5 planes more than 1 Rayleigh length from the focus. PRIMES recommends 
measuring at least 21 planes within 6 Rayleigh lengths.

PRIMES measuring devices with an integrated z-axis enable fully automatic measurement of beam caustics. 
Alternatively, beam caustics can be measured manually. In this case, the position of the focusing optics 
relative to the measuring device head must be manually adjusted before each plane measurement.

Calculation of caustic parameters by fitting

In this case, the elementary caustic parameters of the laser beam are determined mathematically by fitting a 
hyperbolic graph to the measured radii (caustic fit). Using these parameters, it is also possible to derive the 
parameters for the focusability of the beam that is to be measured.

Given that the caustic fit takes into account all measurement points, not all the beam waistlines determined 
by LDS are necessarily located at points along the propagation axis where the smallest radii were measured. 
As a rule, however, the focal radii thereby calculated are very close to the smallest measured radii.
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8	 Discussion of measurement results and troubleshooting

8.1	 Inaccuracies with measurements beyond device specifications

If measurements are made beyond the limit values specified for a device, a reduction in measurement 
accuracy must be expected. 

	X Before measuring, be sure to read the device operating manual. To ensure safe use and accurate 
measurement results, observe all limit values specified therein.

In the case of some parameters (e.g., power, beam diameter, divergence angle), the measured value is 
compared with device-specific limit values. Any violation of limit values is saved with the measurement and 
displayed in the project tree as follows:
•	 Project tree element marked red (see Chapter 5.4.3 “Review of measurements in project tree” on 

page 18). 
•	 Error message in element-related information window (see Chapter 5.4.2 “About the project tree 

elements” on page 17). 

In some tools, a violation of a limit value is indicated by colored markers (see Chapter 8.2 on page 140).

8.2	 Review of parameters with colored markers

In many instances, it is possible to review parameters on the basis of limit and warning values specially 
configured for this purpose. These parameters are automatically compared with limit and warning values and 
the result is shown by colored markers.

Here, parameter refers to all parameters displayed in LDS, regardless of whether they concern data for the 
purposes of measurement (e.g., flow rate, signal-to-noise ratio, fill factor) or the results of a measurement 
(e.g., laser power, M2, average fit deviation).

The review of a parameter can be displayed either directly or indirectly. In many tools, numerically displayed 
parameters can be directly reviewed on the basis of their background color. By contrast, in a project tree 
or Evaluation traffic light tool, the use of color provides a general indication that at least one underlying 
parameter has violated a limit or warning value.

In addition, some of the tools used to create graphs feature an option to show limit and warning values in the 
coordinates window.

8.2.1	 Limit and warning values

In LDS, all configured limit and warning values apply globally; i.e., to all open projects, including their sub-
elements. However, the type of marking may differ from one area of LDS to another (tools and project trees).

General configuration of limit and warning values

Tab. 8.1 on page 140 provides an overview, with examples, of the configuration of limit and warning values 
in LDS. It is immaterial which and how many values are configured for a parameter. These values may be 
either factory configured or freely configured by the user. The < symbol shows the mandatory size relation 
between configured values. If a limit and a warning value are simultaneously violated, the warning value is 
marked.

Parameter Lower values Upper values

Designation Configuration Limit  
value < Warning 

value < Warning 
value < Limit  

value
Ellipticity Freely configurable 0.87 0.90

Fill factor (86%) Factory configured 0.60 0.75

P in W Factory configured 0.0 10.0 500.0 1000.0

Tab. 8.1:	 General configuration of limit and warning values, with examples
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Factory-configured values

In LDS, certain warning or limit values are factory configured. These settings may not be altered by the user. 
Based on the relevant reviews, it can be deduced whether and how the measurement setup or parameters 
must be altered in order to improve a measurement. Why are limit values factory configured?

•	 Factory-configured limit values provide general criteria for the validity of a measurement. By validity,  
we mean the conformity of a measurement with ISO 11146 and/or the quality criteria specified by 
PRIMES. If at least one such value is violated, then the measurement is considered invalid with respect  
to these criteria.

•	 Factory-configured limit values provide device-specific criteria for the safety and quality of a 
measurement. If measurements are made outside of device-specific limit values, devices may be 
damaged, or persons injured. At the very least, a reduction in measurement accuracy must be expected. 
Further information can be found in Chapter 8.1 on page 140.

On the other hand, the violation of factory-configured warning values indicates that the measurement setup 
or measurement parameters are not ideal. These warning values may be general or device specific.

Freely configurable values for custom purposes

Limit or warning values that are not factory configured can be customized as required. If, for example, only 
the upper limit value for a specific parameter is factory configured, then the remaining values below this limit 
may be freely configured.

1.	 Select Measurement environment > 
Limit values in the menu bar.

	A toolbench of the same name 
opens. The choice of tabs depends 
on which project tree element is 
currently selected. If, for example, the 
element Caustic is selected, then the 
toolbench features the corresponding 
tabs Plane parameters and 
Caustic parameters.

In LDS, all configured parameters 
apply globally, irrespective of 
which project tree element is 
selected; i.e., to all open projects, 
including their sub-elements.

Toolbench Limit values

2.	 If required, open additional tabs by 
pressing and holding the left mouse 
button and dragging a suitable project 
tree element into the toolbench. 
In the case of the element Series,  
all available tabs are shown.
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3.	 Configure limit and warning values  
as required.

If, in the English user interface, 
a comma is entered, this is 
automatically replaced by a  
period (and vice versa).

4.	 If required, click the checkbox of a 
parameter in order to activate the 
configured values.

	X If required, select from the menu File 
one of the following items:

•	 Load limits opens a Windows 
Explorer window for the purpose of 
opening a file with the extension .xml. 
This file contains a configuration of 
limit values.

•	 Save limits opens a Windows 
Explorer window for the purpose of 
saving a file with the extension .xml. 
This file contains a configuration of 
limit values.

•	 Default limits deletes all configured 
values.

This applies to the configured 
values for parameters in all tabs! It 
is immaterial which tab is currently 
in the foreground when this 
command is executed.

8.2.2	 Overview of tools with review functions

LDS area/tool Description of review function

Project tree Element review based on different colors for the element icon.

Red Indicates a warning in the following cases:
•	 The measurement was performed outside of device 

specifications.
•	 At least one of the measured parameters is invalid.
•	 At least one of the measured parameters lies outside of the 

permissible limits for the reference measurement, as defined 
by the user (only for the element Caustic).

Gray There is no warning.

Further information can be found in Chapter 5.4.3 “Review of measurements 
in project tree” on page 18.

Caustic analysis

Plane analysis

Raw beam analysis

In the table of the Review tab: 
Review of the validity of a displayed parameter by means of different 
background colors.

Red The parameter is invalid. A limit value factory configured as a 
criterion of validity has been violated.

Green The parameter is valid.

Further information:
Plane analysis: Chapter “The Review tab in the Plane Analysis tool” on 
page 80.
Caustic analysis / Raw beam analysis: Chapter “The Review tab in the 
Caustic Analysis tool” on page 103).
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LDS area/tool Description of review function

Results table
Review of a displayed parameter by means of different background colors.

Red A factory or freely configured limit value has been violated.

Neutral No limit valid has been violated.

Further information can be found in Chapter 6.2.1 “Results table” on 
page 44.

Measurement value display
In numerical display mode:
Review of a displayed parameter by means of different background colors.

Red A factory or freely configured limit value has been violated.

Yellow A factory or freely configured warning value has been violated.

Further information can be found in 
Chapter 6.2.3 “Measurement value display” on page 50.

Evaluation traffic light
Indirect traffic light review of selected parameters in the background

Red At least one factory or freely configured limit value has been 
violated.

Yellow No violation of a limit value, but violation of at least one factory or 
freely configured warning value.

Green No limit or warning values have been violated/configured.

A table appears when the mouse cursor is hovered over the traffic light view. 
Direct review of a displayed parameter by means of different background 
colors.

Red A factory or freely configured limit value has been violated.

Yellow A factory or freely configured warning value has been violated.

Green The parameter lies within the configured limit or warning values.

Neutral No limit or warning values have been configured.

Further information can be found in Chapter 6.2.6 “Evaluation traffic light” on 
page 62.

Graphic data analysis
When the option Show limit values is activated:  
Shows the limit and warning values of a selected parameter in the 
coordinate system.

Red Display of minimum/maximum limit values with the inscription 
Minimum/Maximum

Yellow Display of minimum/maximum warning values with the inscription 
Minimum warning / Maximum warning

See also Chapter 6.2.5 “Graphic data analysis” on page 56.

Power measurement
Permissible variations for specific background parameters are factory 
configured in the measuring devices (e.g., flow rate). If a background 
parameter moves beyond this permissible variation, then the corresponding 
value is shown against a yellow background. This may indicate that the 
device cannot be used safely or that the accuracy of measurement results is 
reduced.

Tab. 8.2:	 Overview of tools with review functions
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8.3	 Low signal-to-noise ratio

A low signal level often results in a low signal-to-noise ratio. This in turn leads to increased unreliability in 
determining radii and the focus position. In this case, check the measured values carefully for consistency, 
or, if possible, improve the signal-to-noise ratio. In general, the signal-to-noise ratio can be improved by 
averaging during measurement.

8.4	 A focus shift and the temporal stability of measurement results

Alongside the quality of individual measurements, the question often arises as to whether the results of 
different measurements are comparable with one another. In certain cases, measurement results that were 
carried out at different times but under otherwise seemingly identical conditions may differ from one another. 
Such discrepancies may be the result of a thermally induced focus shift. 
 
A variety of factors may cause a focus shift. A significant factor is laser power. Transmissive laser optics 
absorb a certain part of the thermal energy of the laser beam. This has an impact on their expansion and 
refractive index. The greater the power of the laser beam, the more the focal length of an optical component 
changes. In order to evaluate a focus shift, therefore, it is often useful to compare caustics at low and at high 
laser power.

If laser power is adjusted by means of pulse-width modulation, a modulation at the pulse frequency may 
occur. This causes a periodic modulation of the measurement result. In some cases, superpositions may 
occur. Transmissive optics, such as out-coupling plates and lenses, may take some time to reach thermal 
equilibrium after the laser is switched on. During this time, the refractive index changes and, in some 
instances, the thickness of the optical material. A resulting focus shift should therefore be taken into account 
when evaluating the measurement results. Alternatively, the measurement should only be started after 
adequate thermalization time. 
In order to measure the thermalization of the optics, a defined time interval must be selected between 
switching on the laser and starting the measurement.

Other factors may also favor a focus shift. These include the structure and absorption characteristics of the 
optics (e.g., the ratio of the focal lengths of focusing and collimating optics). Contamination of the optical 
elements can also be a key factor in causing a focus shift. These are largely the result of the laser processes 
themselves and, as a rule, cannot be avoided entirely, even with appropriate protective measures.

8.5	 Evaluating a result in different versions of LDS

If identical beam geometry measurements are evaluated in different versions of the LDS, the results may 
differ slightly. This is especially the case when, in the current version of LDS (LDS 1.3.1, file extension .lpf), 
measurement data are evaluated that were created with the previous version (LDS 2.98, file extension .foc). 

The following factors may lead to a difference in results:

•	 Radius determination according to the 86% method is performed experimentally. In general, deviations of 
up to 3% are possible and permissible.

•	 The current version of LDS uses enhanced algorithms compared to the previous version. This is enabled 
by general advances in PC computing power.

•	 In the current LDS, radius calculation is performed with an improved iterative process. In contrast to the 
previous version, not only the measurement window but also the ROI (region of interest) is defined. This 
is the area of the measurement window that is used for the actual calculation of the beam radius. Further 
information can be found in Chapter “Fill factors” on page 136.
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